LIBRARIAN ASSOCIATE 1
Popular Library/Teen

Grade 6-A Salary:

General Statement

Under the direction of the Department Manager provides technology and software related
assistance in the department’s Technology Center and performs a range of
paraprofessional tasks and related duties as required.

General Responsibilities

Assists patrons with access to PCs per departmental policies, and provides basic
orientation as needed. Teaches basic computer and software classes for the public. Assists
patrons with software applications including Office 2000 Professional, Print Shop, Money,
as well as online TLCPL resources, and general worldwide web searching. Provides minor
troubleshooting and instruction for PCs, printers, scanners, etc. Maintains records of
problems and places repair logs with IT as needed. Maintains current computer skills and
is alert to industry and professional practices. Conducts basic reference searches, answers
routine reference questions, and provides information and guidance to patrons. Keeps
informed of library policies and procedures, and participates in appropriate workshops
and seminars to expand and enhance skills. May be assigned to in-house committees and
may serve as the Library’s representative on community committees. Works cooperatively
with staff members. Performs other related duties as assigned for the efficient operation of
the Popular/Teen Library and the Library system.

Knowledge and Abilities Reguired

Familiarity of professional library principles, methods, and procedures. Ability to
communicate effectively with Library users and staff. Good public service skills.
Knowledge of popular software applications and the ability to learn new applications.
Demonstrated knowledge of library automated catalog and other electronic resources.
Ability to establish and maintain effective working relationships with associates and to
relate to patrons of all ages and from diverse socioeconomic and ethnic backgrounds.

Requirements and Qualifications

An Associate’s degree or equivalent, preferably in computer technology or a closely related
field required. Must be able to meet the flexible scheduling requirements of the
Department and the Library and be able to perform the essential functions of the position.
Upon appointment a valid driver’s license or access to transportation as needed is required.

Toledo-Lucas County Public Library

Bargaining Unit: APLE

Status: FT

OPERS: *Salary reflects the OPERS pick-up (retirement) paid by the Library as the employee’s contribution.
Established: January 2005



DRIVER/CIRCULATION CLERK III

Outreach Services Department

Grade: 3 Salary:

General Statement

Responsible to Manager of Special Services and bookmobile librarian while on the road for safe
operation of the bookmobile, taking a lead role, and efficiently performing circulation routines
and related duties while serving the public with courtesy and friendliness.

General Responsibilities

Drives the bookmobile safely and is alert to indications of vehicle problems that need
maintenance. Leaves the bookmobile interior clean and ready for the next day’s route. Performs
circulation procedures in the areas of charging and discharging of loan materials; accepting and
computing of fines; registering new borrowers; processing overdues, reserves, interloans, and
branch loans. May be assigned specific areas of responsibility. Assists in ensuring the efficient
operation of the circulation desk by communicating information, keeping the circulation area
organized and recommending improvements. May verify and process registrations. Assists in
coordinating orientation, scheduling and assignments. Assists, as needed, with the daily and
weekly schedules. May assist the Supervisor with ordering and maintaining supplies. Serves as a
lead staff member interpreting and defining circulation policies and procedures. Directly assists
patrons in solving circulation problems and concerns. Answers telephone calls and provides
information to the callers or directs calls to the supervisor and/or professional librarians.
Prepares receipts at the desk according to established routines and policies. Keeps informed of
library policies and procedures, and attends workshops and seminars to expand and enhance job
skills. May be assigned to rotate to perform duties and assignments at other Library facilities.
May be required to perform other duties that are necessary for the efficient operation of the
agency and the Library.

Knowledge and Abilities Required

Ability to perform detailed tasks neatly and accurately. Ability to interact pleasantly with library
patrons of all ages from diverse socioeconomic and ethnic backgrounds. Ability to operate a
variety of office equipment. Ability to accurately total copy sheets and balance the cash book.
Skill in following directions and performing routine clerical tasks. Ability to handle book trucks
used to transport materials. Knowledge of circulation policies and procedures. Ability to
communicate and work cooperatively and effectively with your supervisor and co-workers.
Ability to work independently.



Requirements and Qualifications

High school diploma or GED required. Required to accurately type 35 wpm. Previous experience
as a Circulation Clerk preferred. Customer service and/or public service experience required.
Dependability required. Ability to meet the varied scheduling requirements of the agency and the
Library required. Ability to perform the essential functions of the position required. Must have
physical ability to lift, load and unload up to 75 pounds of library materials and equipment.
Driving record must be free of moving violations for the last three (3) years. Possession of a valid
driver’s license and ability to meet the library vehicle insurance requirements required.

Toledo-Lucas County Public Library

Bargaining Unit: CWA
Status: FT
OPERS: *Salary reflects the retirement pick-up paid by the Library as the employee’s contribution.

Revised: February 2006



@CCESS CENTER: the Public Library of the Future

ID  Task Name Duration | Start Finish : 2009 2010 i 2000 2012
troitr tro ot trotroofroite e ide ftroitr St itr it tr
1 PLANNING, ENGINEERING, & CONSTRUCTION DOCUMENTS 194 days | Mon 6/1/09 Thu 2/25M10
2 Program Planning h 45 days Mon 6/1/09 " Fri 7/31/09 Completed
3 Pre-Curriculum & Classes Defined 90 days Mon 6/1/09 Fri 10/2/09 = Completed
4 Partnerships and Fundraising 180 days Mon 6/1/09 Fri 2/5/10 bngoing
5 Floorplans and Bid Specifications 90 days Mon 8/3/09 Fri 12/4/09 oﬁrnpleted - Ready to Issue
6 CyberMobile Layout and Engineering 30 days Mon 11/2/09 Fri 12/11/09 T SA Contract -- Ready to Award
7 Cost Estimates, BOM, Network Designs, and Topology 30 days Mon 1/11/10 Fri 2/19/10 g :‘Completed
8 Building Permits 1 day Mon 2/15/10 Mon 2/15/10 } ;Received
9 Board Approval -- Apply for Grant & Matching Funds 1 day Thu 2/25/10 Thu 2/25/10 ‘ 2/25
10 ISSUE BID - Kent 43 days Wed 9/1/10 Fri 10/29/10 : L
11 Issue RFP - Blueprints & Specifications 21 days Wed 9/1/10 Wed 9/29/10 &Buehrer Group
12 Pre-bid Meeting 1 day Thu 9/30/10 Thu 9/30/10 [fuehrer Group
13 Bid Due Date 1 day Fri 10/1/10 Fri 10/1/10 uehrer Group
14 Board Approval -- Contract Awards 1 day Thu 10/28/10 Thu 10/28/10 iBuehrer Group
15 Execute Contracts 1 day Fri 10/29/10 Fri 10/29/10 & 1029
16 PRE-CONSTRUCTION - Kent 64 days Wed 9/1/10 Mon 11/29/10 "
17 Public Notification & Media Alerts 5 days Wed 9/1/10 Tue 9/7/10 LTLCPL
18 Close Branch 1 day Wed 9/8/10 Wed 9/8/10 TLCPL
19 Pack/Move Contents 21 days: Thu 9/9/10 Thu 10/7/10 [ TLCPL
20 Site Prep Work 21 days Mon 11/1/10 Mon 11/29/10 E TLCPL :
21" CONSTRUCTION - Kent 300 days Mon 11/110 Fri 12/23/11 —
22 Demolition 20 days Mon 11/1/10 Fri 11/26/10 General Contractof
23 Mechanical 45 days Mon 11/29/10 Fri 1/28/11
24 Interior Walls 30 days Mon 1/31/11 Fri 3/11/11
25 Plumbing 20 days Mon 3/14/11 Fri 4/8/11
26 Electrical 75 days Mon 4/11/11 Fri 7/22/11
27 Roof 60 days Mon 7/25/11 Fri 10/14/11
28 Floors 30 days Mon 10/17/11 Fri 11/25/11
29 Furnishings, fixtures, and equipment (FF&E) 20 days Mon 11/28/11 Fri 12/23/11
30 TECHNOLOGY - Kent 127 days Thu 9/1/11 Fri 2124/12
31 Infrastructure (CAT 6) As-Builts w/ Test Results ’ 1 day. Thu 9/1/11 Thu 9/1/11 :
32 “install AV & Control System ’ 60 days Thu 9/1/11 Wed 11/23/11 77 Torrence Sound
33 Order Broadband WAN Upgrade 1 dayz Mon 9/19/11 Mon 9/19/11 [}Buc;keye Telesystems
34 Order Data Network Equipment & PCs 1day. Tue 9/20/11 Tue 9/20/11 TLCPL
35 Order Training Room Equipment 1 day Wed 9/21/11 Wed 9/21/11 TL¢PL
36 Order PC Software -- MSOffice Pro, Envisionware LPT:One, Altirus 1 day Thu 9/22/11 Thu 9/22/11 { TL¢PL
Licenses, Kaspersky, DeepFreeze, ZoomText, Jaws, Natural Reader, :
& Dragon :
37 Equipment On-site 1 day Mon 10/10/11 Mon 10/10/11 - ’710110
Task Milestone ’ External Tasks
gra‘ij;c&;i’g%iﬂ% Split Summary H External Milestone
Progress (ST, = Project Summary Deadiine
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@CCESS CENTER: the Public Library of the Future

ID  Task Name Duration Start Finish e 200 2012 . :
Al itr ot itritr it ittt

38 Install Router, Metro WAN, and Switches 5 days Tue 10/11/11 Mon 10/17/11 Meyer Hill Lynch
39 Build Servers & Image PCs 2 days Tue 10/18/11 Wed 10/19/11 Meyer Hill Lynch
40 " Setup Authentication, VPNs, Domains, etc. 2 days Thu 10/20/11 " Fri 10721711 Meyer Hill Lynch
41 Install Phone System 5 days Mon 10/24/11 Fri 10/28/11 : yer Hill Lynch
42 Install PCs, Laptops, Printers, Scanners, etc. 10 days : Mon 1/2/12 Fri 1/13/12 Meyer Hill Lynch
43 Install Jaws, ZoomText, Natural Reader, and Dragon 5 days' Mon 1/16/12 Fri 1/20/12 ‘L. Meyer Hill Lynch
44 Access Existing Databases -- 100+ Research dbs 1 day Mon 1/23/12 Mon 1/23/12 TLCPL
45 Promedica Hospital's Weliness Database 1 day Tue 1/24/12 Tue 1/24/12 ‘hTLCPL
46 ConnectOhio's Online Training Content 3days: Wed 1/25/12 Fri 1/127/12 :|yTLePL
47 Test and Final Accept 20 days Mon 1/30/12 Fri2/24/12 : TLCPL
48  CYBERMOBILE 225 days Fri 4111 Thu 2/9/12 ~
49 Order Vehicle -- Farber Speciality Vehicles 1 day Fri 4/1/11 Fri 4/1/11 411
50 Vehicle Construction -- Manufactures Facility 150 days Mon 4/4/11 Fri 10/28/11 y
51 Resolve Vehicle Parking 20 days Fri 6/10/11 Thu 7/7111 TLCAL:
52 Order Data Network Equipment & PCs 1 day Mon 10/31/11 Mon 10/31/11 TLCPL
53 Order PC Software -- MSOffice Pro, Envisionware LPT:One, Altirus 1 day Tue 11411 " Tue 111111 TLCPL

Licenses, Kaspersky, DeepFreeze, ZoomText, Jaws, Natural Reader, ;

& Dragon :
54 Order 3G Broadband Circuits/Cards 1 day Wed 11/2/11 Wed 11/2/11 Verizon
55 Order ZoomText and JAWS software 1 day Thu 11/3/11 Thu 11/3/11 TLCPL
56 Take Delivery of Vehicle 1 day Mon 12/12/11 Mon 12/12/11 ’ 12112
57 Build Servers & image PCs 2 days Fri 1/20/12 Mon 1/23/12 ‘| .Meyer Hill Lynch
58 Install/setup Router, 3G Broadband, and Switch 3 days Tue 1/24/12 Thu 1/26/12 Meyer Hill Lynch
59 Setup Authentication, VPNs, and Domains 2 days Fri 1/27/12 Mon 1/30/12 Meyer Hill Lynch
60 Install Public PCs, Printer, Scanner, etc. 3 days Tue 1/31/12 Thu 2/2/12 @neyer Hill Lynch
61 Test and Final Accept 5 days Fri2/3/12 Thu 2/9/12 ﬂ TLCPL
62 {CURRICULUM / PROGRAMMING 155 days? Wed 9/7/11 Tue 4/10/12 ﬁ
63 Finalize Curriculum, Classes, and Instructors 60 days Wed 9/7/11 Tue 11/29/11 L & Partners
64 Finish Development of Content & Materials 60 days Wed 11/30/11 Tue 2/21/12 2|, TLCPL & Partners
65 Confirm Schedules, CyberMobile Stops, and Partners 1 day Wed 2/22/12 Wed 2/22/12 © L.TLCPL & Partners
66 " Advertise Classes -- Website, Local Media, Flyers, etc. 30 days Thu 2/23/12 Wed 4/4/12 ] TLCPL
67 " Unpack / Replace Content at Kent 22 days? Thu 3/112 Fri 3/30/12
68 Courses Begin at Kent 1 day Tue 4/10/12 Tue 4/10/12 ’ 410
69 Begin CyberMobile Routes 1 day Tue 4/10/12 Tue 4/10/12 ’ 410
70 STAFFING 109 days Thu 11/10/11 Tue 4/10/12 T
7 Develop Staff Training Program & Materials 30 days Thu 11/10/11 Wed 12/21/11
72 Hire 1 FTE driver, 2.5 FTEs Library Associate 1, & PT Tutor 1 day Wed 2/1/12 Wed 2/1/12 } TLCPL
73 Staff Training 30 days Thu 2/2/12 Wed 3/14/12
74 Go Live 1 day Tue 4/10/12 Tue 4/10/12 : ‘ 4110

Task Milestone ’ External Tasks
E';J:c&;irgfgﬂ% Split o Summary H External Milestone
Progress RS, Project Summary Deadline <

Page 2




Board motion February 25, 2010

approved the Buildings and Grounds Committee recommendation to accept a gift Property
of property. The subject property is 3404 Lagrange Street and is adjacent to our
Lagrange Branch Library to the South. It is currently an abandoned auto repair
shop and was previously a small gas station. The Library administration has been
pursuing the acquisition and all associated issues for several months. The
Buildings and Grounds Committee has also met and discussed the matter at
multiple meetings. All zoning, encumbrances and environmental due diligence
has occurred. The Library will assume legal and appraisal fees incurred by the
current owner. Ohio revised code 3375.33 and 3375.40 authorizes Library Boards
to acquire “real property”. This .337 acre parcel will allow for the addition of 21
needed parking spaces. All reviews have occurred with the exception of a final
plan commission approval that is now in process. We fully accept approval from
the commission. With that as the only remaining contingency, the committee is
comfortable accepting the property gift (actual cost $1.00).

Mrs. Odesky brought forth the motion recommended by the Community Broadband
Relations Committee, seconded by Mr. Tucker, all voting aye that the Library Technology
apply for federal stimulus money through the Broadband Technology Opportunities
Opportunities Program (BTOP)to place a Public Computer Center at Kent Branch  Program

and further to provide mobile computing services to senior centers, housing (BTOP)

units, and youth organizations in Toledo. The intent of the Public Computer
.- Center /mobile unit is to provide access to broadband/Internet resources for

----------

voririiielei+i Toledo’s most vulnerable populations and to offer them job and life skills

----------
---------

et e computer training. The renovation of Kent Branch is necessary so that it can
function as a 21* century public library with adequate spaces for books,
magazines, AV and computers to meet the needs of its population. The total cost
estimate for renovating Kent Branch, purchasing a mobile computer lab and
adding staff to assist patrons at Kent and Outreach Services is $3,090,936 with a
federal match of 70% and a Library match of 30%. BTOP awards will be
announced beginning in June 2010 with all grants awarded by September 30,
2010. '

The Library will apply for a BTOP: Public Computer Center with the Library

matching $927,281 towards the federal match of $2,163,655 for a project total of
$3,090,936

The Board heard brief comments from Harry Johnston, Communication Workers Staff
of America. Mr. Lutz, APLE had no comments. Organizations

Toledo-Lucas County Board Library ~ Board of Trustees Minutes  February 25, 2010 22



JULIA R. BATES

LUCAS COUNTY PROSECUTING ATTORNEY

Lucas CounTy CourTHoUSE, 700 ApamMs STREET, Suite 250, ToLepo, OHlo 43604-5680
TELEPHONE (419) 213-4700 / FACSIMILE (419) 2134595

February 26, 2010

Assistant Secretary

National Telecommunications and
Information Administration

U.S. Department of Commerce
Washington, D.C. 20230

Re: Toledo-Lucas County Public Library

!
e

Dear Sir:

We are general counsel for the Toledo-Lucas County Public Library, (the “Applicant.”)

In such capacity, we acted as counsel to the Applicant in connection with its ability to apply

. to the Broadband Technology Opportunities Program and in the review of the grant
agreement, as referenced in the Notice of Funds Availability.

We are of the opinion that:

(a)  the Applicant is a duly organized and existing legal entity under the laws of the
State of Ohio;

(b)  the Applicant has corporate power: (1) to execute and deliver the agreement,
and (2) to perform all acts required to be done by it under said agreement;

(c)  no legal proceedings have been instituted or are pending against the Applicant,
the outcome of which would adversely affect the Applicant’s ability to perform
the duties under the grant agreement, and there are no judgments against the
Applicant which would adversely affect the Applicant’s ability to perform its
duties under the grant agreement.

Very truly yours,

JULIA R. BATES
Lucas County Prosecuting Attorney

) /
. ;,*'"f y /:/// ".. {
B)(l/”"'\/ébkc«x( »&Zﬁ Ui (e ——

Karlene D. Hénderson
Assistant Prosecuting Attorney

KDH/bma
CIVIL DIVISION CRIMINAL DIVISION FORECLOSURE UNIT GRAND JURY JUVENILE DIVISION VICTIM WITNESS
419/213-2001 419/213-4700 419/213-4061 419/213-4702 419/213-6951 419/213-4591

® iz
SERE:



Call for inspection minimum: 3-5 working days in advance - 419-245-1220

BUILDING PERMIT

DIVISION OF BUILDING INSPECTION - CITY OF TOLEDO, OHIO

N 0 T i c E ! | THESE BLANKS FOR INSPECTOR’S APPROVAL

FOOTINGS PLUMBING ELECTRICAL HEATING

CALL FOR BUILDING INSPECTION AIR CONDITIONING

BEFORE (1) POURING CONCRETE FOOTINGS “SEPARATE | PERMITS | REQUIRED”
(2) COVERING WALLS

ROUGH BLDG

AFTER (3) COMPLETING PROJECT
Date _3 -S-1 a
Owner T R L

Contractor_jBD

St. and No. &1 I e
Permit No._: - | FINAL FINAL FINAL FINAL

« THIS CARD MUST BE TACKED ON STREET SIDE OF BUILDING =



-, , CITY OF TOLEDO

E y S 3 F 4 § T ]

vivision of Building Inspection

Drss Govertment Canter, 3oite 1600, Tolode, G4 43808  [wATL) PO ROy 844, Teleds, o $3647
Telephomey 413 2451240 W telegn ol gy Faxs 410-0435-1329

PERMIT TYPE: BUILDING, SUBTYPE - COMM/4FM

PRINTED:03-05-2010
PERMIT #: BB09-01808 DATE ISSUED: 03/05/2010
STATUS: ISSUED ISSUED BY: ZERVOSC

JOB ADDRESS: 3101. COLLINGWOOD BLVD TOL
LOCATION OF WORK:

OWNER INFORMATION

419-259-5309 .
TOLEDO-LUCAS COUNTY PUBLIC LIBRARY TOLEDO LUCAS PUBLIC LIBR 325 MICHIGAN ST TOLEDO, OH
43624

APPLTCANT INFORMATION
419-893-9021
BUEHRER GROUP ARCHITECTURE & ENGINEERING INC 314 CONANT MAUMEE OH 43537

- CONTRACTOR INFORMATION

THE FOLLOWING WORK IS AUTHORIZED BY THIS PERMIT:

PERMIT SUBTYPE: ADDCOM, COMMERCIAL ADDITION

ALTERATIONS(#): 1, sQ FT(#): 17766, TENTS(#): 0, BOOTHS(#): 0
OCCUPANCY TYPE: LIBRARY
USE GROUP(S): ASSEMBLY RECR/AMUSE/WORSHIP/OTHER
WORK CLASSIFICATION:
UNITS: 0
APPEAL CASE#: ORDINANCE #:
CONSTRUCTION TYPE: 2B
WORK DESCRIPTION: NEW ADDITION & INTERIOR ALTERATIONS TO EXISTING LIBRARY
ZONING DISTRICT:
PERMIT FEE: $2,794.90

Administrative Fees

Early Start (Y/N): ] $0.00
ReInspection Fee: $0.00
I1legal Occupancy: $0.00
Inspection w/0T: $0.00
Investigation Fee: $0.00
other Fee (desc. below): $0.00
Surcharge: $86.85
pPlan Review - Structural: $100.00
Plan Review - Non-Structural: $0.00
Temp, Occupancy Commercial: $0.00
Final occupancy Commercial: $65.00

COMMENTS: LOG #11-21
FEE _TOTAL: $3,046.75

: This Permit and Approved Plans Must Be Kept on Premises. .
The approval of plans procured by misrepresentation of facts or conditions or 1mproqer action by any

officer or employee of the Division of Building Inspection, does not Tegalize any illegal construction
or agreement.

In consideration of the granting of this qermit, the applicant did agree to hold the City of Toledo
harmiess from an¥ and all damages. The applicant did covenant and agree to construct said work in all
respects in compliance with the provisions of the Statutes of the State of ohio and the ordinances of
the city of Toledo. The applicant did covenant and agree that orders of Division of Building Inspection
will be complied with. The applicant further agrees to dispose of all construction waste materials in
accordance with applicable city laws.




Basic Computer Skills

VvV V.V V VY VYV V VY VY VYV V VYV V V VY V VYV

Windows and its components
Desktop

Taskbar

Start Menu
Minimize/Maximize/Close Buttons

My Computer

Click either the left button or the right button

Multitasking

Highlight

Copy/Cut and Paste text
Save and/or Save As

Print Command

New Folder

Copy/Move files

Drag and Drop

File types with varying extensions
Create shortcuts

Hard drive and floppy drive

Rename/Delete

Powor
Supply

AGH (Video)

PEE

Expansion

Slots

CE-ROM

Floppy
Driva

Hured
Drive



Windows and its Components

The main components of Windows when you start your computer are the Desktop, My
Computer, Recycle Bin, Start Button, Taskbar, and shortcuts to applications.

After opening an application, you will also have a window with an active application that will
appear in your desktop and taskbar.

ﬁ gg ﬁ‘ ' Dasktob .

By ncsreents . Ao Wrdlows
Raader 5.0 Evplyrsc(2)

My Computer ' Active application

E! My Compier

Racy&!a bhin

Regydeity

Shortcut fo application

Start hutton Teskhar

Deskto

The Desktop is the very first screen you see after Windows starts. There you find the folders:
My Documents, My Computer, the Recycle Bin and any Shortcuts for applications and files that

you have created.

My Computer

When you double-click on the My Computer icon on the desktop, it will open a window similar
to the one shown below, where you can navigate between the computer's drives and Control

Panel tools.

CFle Bt View ! Favotes Yook Wb
bt s e < (6] | Dseach P Folders @]Qgﬁ; xm]ﬁg'
Aecms I@mcmm > P
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Displays the fles andfolders onyowr -~ comral panel
conper :
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Docurrents

by 2 et Ml
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Recycle Bin

When you delete a file from your computer's hard drive, it is removed to the
called Recycle Bin. Files deleted from your hard drive are still available for |

restoring if needed, unless you empty your Recycle Bin.

e To restore the files, open the Recycle Bin folder by double-clicking
the icon on your desktop, select the file and then select Restore.

¢ To clear the Recycle Bin, select Empty Recycle Bin and the files will be permanently

removed from your computer.

& Recycle Bin
Fls Ede View Favoriter

“Tools - Help

5 X0

SB[ ek (DiFokders (] |

s [B rcydon — ew
bt L_j “Narme . f]OrigmlLbcatbn

Llayj {1hiot C:\My Documents

: E Mecom Ci\My Documents
Recycle Bin Clinterviews Ci\My Documents

This folder contains fles and folders
that you have deleted from your
camputer,

To permanently remove sl kems and
veclgim disk space, click:

i Empty Recycle Bin

To move all items back ko thelr original
lacations, clicks

i Restore Al ]

Select mnitem bo view its dascdption,

Note that the recycle bin does not apply to the contents of a floppy disk. If you delete a file from

a floppy disk, it is permanently deleted, and you cannot restore it.

Minimize/Maximize/Close Buttons

In the top-right comner of your document are the Minimize/Maximize/Close buttons.

The first one when clicked minimizes your screen, sending it to the taskbar. The second one
maximizes your screen, filling all desktop with the document you are working with. The last

button is used to close your document. Minimize

It is best practice to work with your document window maximized.

Maximize

Start Menu

By clicking the Start button, in the very bottom-left corner of the screen, a vertical window will
come up with the Start Menu.

The list of submenus in the pop-up window let you navigate and select the application you want
to run.




Taskbar

The Taskbar is the row at the bottom of the Windows screen where all currently open
applications or files are listed.

The taskbar is used to select a file or application that is already opened or to put an application in
the foreground.

To put an application in the foreground, just click on the icon of the application in the taskbar.
Another way to put an application in the foreground when more than one is in use is to hold the
ALT button and then click TAB on your keyboard to see all the open applications; you will need
to hold the ALT button and continue pressing TAB to go through each application until you
come to the one you want to use.

Shortcut

A shortcut creates a button or icon which typically stays on the !@ . ’
desktop and when clicked, quickly allows you to start a program or e nE .
open a file without having to go to its permanent location on your bl 522&%&"
computer. .

To create a shorteut, open the Windows Explorer or go to the Start menu, select the file or
program you want to create a shortcut for, place the cursor on the icon for the file, then right-
click and select Create Shortcut from the menu that pops up. The shortcut file will be created.
After that, you drag the shortcut file to the desktop and whenever you click on it, it will open the
application or document related to the shortcut.

1 Ul poganFles
C o { Recnst

L wvwinoows
=
2

Delste
Renoma .

Right and Left Click

To use the mouse, usually you click the left button. However you can also right-click to display
a hidden menu related to the object you are in when clicking. This menu can vary depending on
which application you are using.

With right-clicking, you can operate different functions such as:

» Copy/cut or paste a text, file, or folder.
¢ Rename or delete a file or folder.

EXMy Documents.
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Multitasking

The term multitasking means to be running or working in two or more applications at the same
time. You can be more productive by multitasking. For instance, you can download files from
the Internet while managing your files or word processing.

In order to switch between the applications you can use the Taskbar, clicking on the icon of the
application you want to have in the foreground.

Fltetrs,
Divussic

Hap
[Cinevias

|
! iy F L S

Highlight
Put your cursor at the beginning of a word or sentence you want to highlight, then click and drag
your mouse to the end of the selection.

puter Skills

for n Windows Environment

Basic Computer Skills

for a Windows Environaent

Copy/Cut and Paste Text

Copy is used when you want to have an area of text from a
document twice at the same document or in another document.
You first select the area of the text by highlighting it and then
press CTRL+C, or go to Edit menu and select Copy.

Cut is used to delete an area of text from a document. You
first select the area of the text by highlighting it and then press
CTRLA+X, or go to Edit menu and select Cut.

Paste is used to insert an area of text or image in a document
by hitting CTRL+V or in the Edit menu selecting Paste.
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Another way of using the copy, cut or paste commands is using ~ This paper looks at a large panel of ma Standard and Formatting Toolbars

the right-click button of your mouse. e Cut .
mﬂusiry'_l Toolbars are rows of buttons and boxes. When you click on a button or box, an application opens
1. After highlighting the text you right-click and a menu will fa‘sf‘z;.’] B2 pac or a task is performed. Toolbars normally appear at the top of an application's window. The
appear where you can select Copy or Cut. These n - g Standard Toolbar shown in the image below is from Windows Explorer; the standard toolbars
H 3 strategic’ A Fonte; ol H icati, :
2. To paste you just insert your cursor where you want, ~ , in other applications may have buttons that allow youto open a new document, save, print, and
right-click and select Paste. beragraph spell check.
-3 Bullets and Numbering:.
'@, fperink EBak Y e | Dseardh [ Groers ERTRS IS X
-2z Bynonyms

The Formatting Toolbar is used to format a text using alignments, font type, font size, bold,
italic, and lists. It is provided in most applications. The image below shows the Formatting
Toolbar from Netscape Composer.

Nm ”Vwahk\v‘m!h *raﬁ A.AA{Q“( :*}‘}

Copying or cutting and pasting a text in Microsoft Word:

1. Highlight the text you want to copy or cut, press CTRL+C (for copy) or CTRL+X (for

paste).
Save and/or Save As

you answer the questions below? SRR I W Save s used when:

ol tho Edi View Insett Format

Do you understand the concepts and computer terminology?
If not, be sure to sign up for a Basic Skills technical
wortkshop before undertalding the WebTycho training,

o It is the first time you are saving a file.
¢ You want to keep saving a existing file in different
moments that you are working on it.

- s It is the end of a working period.

Save % webpane . ‘Note that clicking Save will replace whatever file you were

2. Insert your cursor where you want to paste the text.

PR - %’working on.
. & sge Pray] Wi
Do you understand the concepts and computer terminology? —
- Page Setupi. i Go to File menu and select Save or use the combination keys
é print, .. . Culth CTRLAS.

Ifnot, be sure to sign up for a Basic Skills technical
workshop before undertaking the WebTycho training,

[ e tlsave As is used when you want to save a file with a different
L@j Fle Edi View Inseit Forn ‘Logls”name to create backups of a file in the creation process. In that

3. Paste your text by pressing CTRLA+V. The text will appear. J O 0O fewns Gul+nway, you can have different versions of the same document
1 @Er open.i. - - ctvlw‘and can return to a previous stage.

Close: Vo ‘
Do you understand the concepts and computer terminology? B e T Cula Suo to File menu and select Save As or use the combination
Can you answer the questions below?| BT keys CTRL+SHIFT+S.
If not, be sure to sign up for a Basic Skills technical [y save e Pags:,
workshop before undertaking the WebTycho training. = —

Web Page Preview:
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Print Command

To print a page go to the File menu and select Print. A window will pop up with options for how
many copies and which pages you want to print. Other options are also available depending on
the printer.
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New Folder

To create a New Folder, which means a new directory (a place where documents from the same
subject are stored), go to the File menu, then New and select Folder from the pop-up menu,
either in My Computer or in Windows Explorer.

To open Windows Explorer, click the Start button, select Programs/Accessories/Windows
Explorer.
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Copv/Move Files

To copy and move a file or folder, use Windows Explorer.

To open the Explorer application, click the Start button and select Programs and Windows
Explorer (some computer have Explorer under Programs/Accessories).

Copy or move a file using Menu command:

Select the disk drive that contains the file by clicking twice on it.

Click on the folder where the file is located

Select the file by clicking on it.

Go to Edit menu, select Copy (if you want to retain a copy of the file in the original
place) or Cut (if you want to move the file).

Navigate to the new location where you want to paste the file.

Go to Edit menu, select Paste.
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The same procedure can be used if you want to copy or move an entire folder.

i xl

oW (Favontes [Took | Help W
@ée Urida e B 7;;'
Addre L X botiv ] @co [itinks 2
R Copy _ CuhC ey
= Spagte (g

Paste shorteot

Copy To Folder..,

‘Move ToFolder _1
- Select Al rhHA .
¥

Trverk Salacti ‘
nvert Selecti E| KT ey
Coples the selected items to the Clipboard, To put them in the 4

EX My Documents

Fle [ 'Edt View Favorites: Toals -

B Unda iz Himr
- i 1

I'Addre cor T+ ' (
= ¢ __ culc
Folde parmans X T manezz
.
; ] TMANG23
Paste shortei
7 TMANG31
] TMANG32
70 TMANG33
= TMANG40
: REEef bt
Inserts the items you have copied or it into the selected o,




Drag and Drop

Drag is when the mouse button is held down while the mouse is moved. It is mostly used to
move files around in Windows Explorer or in some other applications. Drop is the release of the
button, after finishing dragging the mouse.

Here is an example of dragging and dropping a file from the hard drive to the floppy drive in
Windows Explorer:

1. Select the file, hold down the left mouse button and drag it in the direction of the floppy
drive on the left side.
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2. After the floppy drive highlights you can release the mouse button; the file will be
dropped and copied there.
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File Extensions

A file extension is the three letters of a file name after the dot. It is created by the application
when you save a file. It is the way operation systems identify which application to use to open a
file. Windows often doesn't list them when you are searching for a file, but they are there.
Examples are: .txt, .doc, .exe, .html, .jpg, .gif, .wav.

However, sometimes you will want to save a file with different extensions. In order to do that,
select Save As in the File menu. The Save As box will open. Choose from the drop-down menu
next to Save As Type the type you want to save. The extension of the type will be created for
you by the application.

Here is an example from Microsoft Word:
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Some file extensions:

Graphic files: .bmp, .gif, .tif, .jpg
Word document: .doc

Program file: .exe

Webpages files: .htm, .html
Unformatted text: .txt

Excel spreadsheet file: .xls
Compressed file: .zip

Rich Formatted Text: .rtf

Sound file: .wav

Acrobat Reader file: .pdf



Hard Drive and Floppy Drive

In your computer there are different drives: the hard drive, the floppy drive and the compact
disk drive.

The hard drive, also called the C: drive, is used for storing all your applications and files. The

floppy drive, or A: drive, is used when you insert a floppy disk to store files that you want to
transport or create a back up.

To select the hard drive or floppy drive for file management you can go to either Windows
Explorer in programs or to My Computer on the desktop.

In Windows Explorer select the hard or floppy drive.
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or in My Computer, select the Hard or Floppy Drive.
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To Delete a file or folder:

Floppy Drive A: [d] My Computer
Ff?e Edk VW Fevoes Tools Help " 1. Navigate and select the file or folder you want to delete.
Gsnadi o - (11 | Qsearch [yrolders R IR T X ) 2. Go to the File menu and select Delete.
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Using Windows Explorer you can rename or delete a file or folder. Properti
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To Rename a file or folder: - o
x ful

1. Navigate and select the file or folder you want to rename from the proper drive (c:, a:).
2. Go to the File menu and select Rename.
3. The file name will be highlighted and blinking in the right corner waiting for you to type

the new file name. !
' i = |

»

Another way of renaming or deleting a file or folder is using the right-click button of your
mouse. After highlighting the file or folder, you right-click and a menu will appear where you
can select Rename or Delete.
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Basic Microsoft Word 2007
Class Outline

Getting Started

The Ribbon {formerly the Toolbars)

Quick Access Toolbar
Microsoft Office Button

Working with Documents

Creating a New Document
Open an Existing Document
Save a Document

Save As or Renaming Document

Formatting Text

Changing Font and Size
Font Styles and Effects
Change Text Color
Alignment

Tabs

Graphics

Insert Clipart
Insert Picture
Resize Graphics

Spelling and Grammar

Printing

Check the Spelling and Grammar of a document
Check the Spelling of an individual word

Review Print Options (Print, Quick Print and Print Preview)
Configuring Printing Options

New File Format

Why the change?
Working with documents from past versions of Word - Compatibility



Basic Microsoft Word 2007

Starting Microsoft Word

1. Double click on the Microsoft Word icon on the Desktop Bk

2. Click on Start -> All Programs -> Microsoft Office = Microsoft Office Word 2007

Word Ribbon (formerly the Toolbar)

Inger i Page tagout

catibri {Bady) Sl viAn

1. Tabs -- There are six of them across the top. Each represents an activity area.

2. Groups -- Each tab has several groups that show related items together.

3. Commands --A command can be anything from a button, a drop-down list,
or a box to enter information.

Ribbon Tabs

Jicrasoft Word

view: L
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Shytes

Each of the Tabs contains the following tools:

Home: Clipboard, Fonts, Paragraph, Styles, and Editing.

Insert: Pages, Tables, lllustrations, Links, Header & Footer, Text, and Symbols
Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange
References: Table of Contents, Footnote, Citation & Bibliography, Captions, Index,
and Table of Authorities

Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish
Review: Proofing, Comments, Tracking, Changes, Compare, Protect

View: Document Views, Show/Hide, Zoom, Window, Macros

More commands under each Group:
When you see a small arrow B](called the Dialog Box Launcher) in the lower-right corner of a group, it

means there are more detailed or advanced options available for the commands in the group. Click the
arrow to open a dialog box or a task pane where you can work with the available options.

Quick Access Toolbar
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It contains some commands that you use over and over every day: Save, Undo, Repeat and Print.
You can add your favorite commands to it so that they are available no matter which tab you are on.

To add commands to the Quick Access Toolbar, right-click the command you want to add, and then click
Add to Quick Access Toolbar. Using the drop-down arrow on the right with also add commands.
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The File menu has been replaced in Microsoft Office Word 2007 with the Microsoft Office Button.
Click this button, in the upper-left corner of the program window, to Open, Save, and Print your
documents.

Click the Word Options command at the bottom of the menu and you'll also find the program settings
that control things like your preferences for correcting spelling, which used to be found on the Tools
menu, under Options.



orki ith Documents

Creating a New Document

Go to the Office Button > New

It will show you all the templates that are available which you can use if you want to create a
preformatted document or otherwise you can select to start a blank document.

Open an Existing Document
Just go to Office Button > Open -> select your desired file to open.

Save a Document

To save a document, go to Office Button - Save.

Ifitis a new document, selecting Save will automatically open the Save As dialog so that you can specify
the name of the document and the place where you want to store it.

Save As or Renaming a Document
If you want to save a copy of the document (which will not overwrite the existing document), you should
select the Save As option, go to Office Button -> Save As. Use Save As to rename a document.

Formatting Text

To change the font typeface
= Click the arrow next to the font name and choose a font.

libet Body)s

» Remember that you can preview how the new font will look by highlighting the text, and hovering
over the new font typeface.
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Formatting Text

To change the font size
= Click the arrow next to the font size and choose the appropriate size, or
= Click the increase or decrease font size buttons.

Calibri{Body) i1

Font Styles and Effects
Font styles are predefined formatting options that are used to emphasize text.
They include: Bold, Italic, and Underline.

To add these to text:
= Select the text and click the Font Styles included on the Font Group of the Ribbon, or
= Select the text and right click to display the font tools

sfaces, fontsize, effect =

Change Text Color
To change the text color:

= Select the text and click the Colors button included on the Font Group of the Ribbon, or
= Highlight the text and right click and choose the colors tool.
« Select the color by clicking the down arrow next to the font color button.

A o7

Change Alignment
The paragraph alignment allows you to set how you want text to appear. To change the alignment:
= (Click the Home Tab
= Choose the appropriate button for alignment on the Paragraph Group.
= Align Left: the textis aligned with your left margin
= Center: The textis centered within your margins
« Align Right: Aligns text with the right margin
= Justify: Aligns text to both the left and right margins.




Word 2007 Handaut. doc [Compatibiity Macle] - Microsoft Ward .+

Home 1 ngert Page Layout

|

iReterences Mallings: o Review o View Developer:

‘fﬁ = ;‘Ca‘mt;rla e

' AsBbCeT | AaBbCcl

U Normat |

‘AaBb( AaBbC:

1: Heading 1 .7 Heading 2 i

Cilphoard (i1 ; ; X kS e

Working with Tabs from the Ruler: Moving Tabs
®  On the Ruler, click and hold the tab you want to move
= Drag the tab to the new location and release the mouse button

Working with Tabs from the Ruler: Deleting Tabs
= (Clickand hold the tab you want to delete
* Drag the tab into the document area of the screen and release the mouse button

Graphics

To insert Clip Art
= Place your cursor in the document where you want the illustration/picture
« Click the Insert Tab on the Ribbon
= Click the Clip Art Button
» The dialog box will open on the screen and you can search for clip art.
= Choose the Clip Art you wish to include
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To insert a picture
= Place your cursor in the document where you want the illustration/picture
= (lick the Insert Tab on the Ribbon
= Click the Picture Button
» Browse to the picture you wish to include
= Click the Picture
» Click Insert
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Resize Graphics

All graphics can be resized by clicking the image and clicking one corner of the image and dragging the

cursor to the size you want the picture. \




Spelling and Grammar

To check the spelling and grammar of a document
= Place the cursor at the beginning of the document or the beginning of the section that you want to
check
= Click the Review Tab on the Ribbon
= Click Spelling & Grammar on the Proofing Group.
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= Any errors will display a dialog box thatallows you to choose a more appropriate spelling or
phrasing.
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To check the spelling of an individual word
= Rightclick any word that has beenl underlined by Word and choose from the drop-down list,
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Printan open document by going to Office Button - Print.
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There are three options in Print Menu:
1. Print -- If you select the first option, which is Print, it will give you the print dialog where you can
configure different options.

2. Quick Print -- If you select Quick Print, it will just use the default settings and will print the document
directly. It will not ask you of any configuration settings. So if you have configured your printing settings,
then you can easily print using Quick Print option as it will be faster.

3. Print Preview -- Print Preview will give you the view of how the document will look like after it has
been printed on the paper. So by previewing your document, you can make sure everything is what
you're expecting.
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In print preview, you can change the margins and orientation of the page to be printed. And you can
select the paper being used for printing i.e. whether you're using A4 size paper or a letter or an envelope
etc.

Configuring Printing Options
Go to Office Button = Print. If you need to change any options, do so then select OK.




New File Format

Why the Change?
The new Word document file format is based on the new Office Open XML Formats (XML is short for
Extensible Markup Language). You don't have to understand XML.

Just keep in mind that the new XML-based format:
= Helps make your documents safer by separating files that contain scripts or macros, making it
easier to identify and block unwanted code or macros.
» Helps make your document file sizes smaller.
= Helps make your documents less susceptible to damage.

Working with documents from past versions of Word - Compatibility
In Word 2007, you can open files created in previous versions of Word, from Word 95 to Word 2007.

»  When you save a file that was originally created in a previous version, the automatic option in the
Save As dialog box is to save it as the previous version (.doc).

*  When you save a file as a previous version, if any 2007 features are not compatible with the
previous version, a Compatibility Checker tells you so, and any new features will not work.

Note that when you open a Word file created in a previous version, or when you save a file created in
2007 as a previous version, Compatibility Mode is automatically turned on.

The Compatibility Checker runs automatically. You can also run it manually if you wonder whether any
features in a document will be incompatible with previous versions.

o
Click the Microsoft Office Button <;*‘ -> Prepare > Run Compatibility Checker.

Important Note:
A Word 2007 document cannot be opened in a past version of Word, unless you install the
Microsoft Office Compatibility Pack.



"Fmail Basics"

Kent Branch Library
Computer Classes for Beginners
“Email Basics”

What do | need to use email?

=Computer

=Internet Connection

»Email program or Web Browser

Top Web-Based Email
Providers

Yahoo - Hotmalil
Gmail - AOL

Web Email

Advantages:
* Freedom of movement
= Easyto use
= Free

= Always available

Disadvantages:
» | imited storage space for messages.
= No offline access to your email.

3 things to memorize to use Web
Email

sAddress for the Web page
=Your email name or id

»Your password

Email Security

Whenever you receive or send email, you risk
catching and spreading a computer virus.
Viruses can damage your computer.

Email attachments are the most common form
of virus transportation. If you open an infected
file, there is a good chance of catching the bug.
Never open an attachment unless you know the
sender.

Installing virus and spyware detection software
is recommended.




Phishing

Phishing attacks use 'spoofed’ e-mails and fraudulent
websites designed to fool recipients into divulging
personal financial data such as credit card numbers,
account usernames and passwords, social security
numbers, etc. By hijacking the trusted brands of well-
known banks, online retailers and credit card
companies, phishers are able to convince up to 5% of
recipients to respond to them.

The brands most commonly hijacked are, in order: Citibank,
USBank, eBay, PayPal, and AOL.

Phishing resource: http:/iwww.antiphishing.org/

Protect yourself from
Computer Crime

=Delete all suspicious emails received.

=*Empty your trash folder.

=Never open an attachment unless you know the sender.
=Use extreme caution before giving out confidential data.
=Beware of identity thieves.
=Report SPAM.

=Opt out of SPAM lists.

E-mail in Four Parts

= The Address

= The Attachment
* The Subject Line
= The Body

Anatomy of an Email Address

General format
An email address usually consists of 2 elements:
name@company.organization code.country code

Examples of email addresses for people in the United
States:

janedoe@gmail.com (United States is implied)

jdoe@toledolibrary.org

Examples of email addresses for someone outside the
United States:

john@yahoo.com.de

john@yahoo.com.uk

Addressing Your Email
Message

When Sending Email:
« Write recipients email address every time
you send a message.
» Use an electronic address book.

+ Use of Cc (carbon copy) or Bee (blind
carbon copy.)

* Use of group lists.

« Addresses are automatically entered
when replying to messages.

Writing Good Subiject Lines

»  State your message clearly, Bad Lines |Good Lines
concisely, and descriptively. Tickets Our Lyric

= Consider your primary audience Opera tickets
when writing the s‘ubje‘ct line. Request Request for

» Steer clear of subject lines parts number
commonly used for viruses, Voot Mesting 9a1
spam, or junk. eeting esting Sam

Tues, Room 6




Laboratory
=Establish an email account @ aol.com

Send an email to:
janedoe@aol.com
janedoe@yahoo.com

jane.doe@toledolibrary.org

jdoe@Utoledo.edu




Hands-on Internet Outline
A. Introduction
The Internet is the interconnection of different computers by telecommunications.

The Internet is available to hundreds of millions of users worldwide, 24 hours a
day, 7 days a week.

This class is about the World Wide Web and how to steer through the Information
Superhighway. A different class is offered for using e-mail.

Necessary equipment to connect to the Internet

1.CPU

2. Mouse

3. Keyboard

4. Monitor

5. Modem (phone or cable) - Is the device that allows your computer to transmit
data over phone or cable lines, so your computer can communicate with other
computers on the Internet.

B. Basic Terms

World Wide Web - Specifically it refers to the portion of the Internet dictated by
the HTTP protocol and can be navigated through the use of a browser such as
Internet Explorer or Netscape Navigator.

Really — Electronically linked documents (pages) on the Internet that may contain
text, graphics and audio.

Website — A location or address on the WWW that may contain web documents.

Homepage — The main page of a web site. The Homepage serves as an index or
table of contents to other documents/pages at the site.

Links — A link is a reference to another web document or site inserted into almost
all documents on the Web. Clicking on the link will transfer you from your current
document to another document.

Search Engine — A program accessed through a website that searches web
documents for specified keywords and returns a list of the websites where your
keywords were found.



C. Navigation

Navigation Buttons - Browser

1. Back

2. Forward

3. Stop

4. Refresh (reload)

5. Home (does not appear on Library PCs)
6. Scroll Bars

D. Methods of Searching

URL — (Uniform Resource Locator) The URL is the address of a resource, or
file, available on the Internet.

1. Type an Internet address directly.
- Delete contents of location box.
- Type in URL.
- Click on “Go” or press “Enter”

2. Domain Names — Internet category
- .com

.org

- .mil

- .gov

- .edu

3. Examples of common Internet Addresses
- www.chrysler.com
- www.utoledo.edu
- www.toledolibrarv.org

Guessing the address can be easy, but be warned!
www.whitehouse.gov Vs. www.whitehouse.com

4. Surfing
- Clicking on layers of links
- Example - Library’s Internet link

5. Search Engines
- Examples
A. Google
B. Yahoo
C. Excite
D. Metasearch — Uses multiple search engines at same time



- Example #1
Type: “Ohio Department Aging” in address box

- Example #2, Be Specific, the more terms the better
A. Type: Springfield Schools
B. Type: Springfield Schools Ohio

- Google Specialty Searches

D. Printing
- What you see may not be what you get out of the printer?
- Screen size (visual) may be different than print size.
- Screen layout may be different that print layout.
- Look for “print” or “printable view” button.
- Reformats WebPages for printing.

Example — www.toledoblade.com

1. Click on any article
2. Click on “Print” on top row of article

E. Internet Privacy

Example — www.google.com

1. Type in your phone number, use dashes (419-XXX-XXXX)
2. This only works on “listed” numbers, not “unlisted”
3. Students name and address should appear if a “listed number”

4. Click on “Google Maps” to see visual map of address

F. Conclusion



Mouse Maneuvers -- Setup and Positioning

1. Place your mouse close to your keyboard and within easy reach.

Placing your mouse too far away can cause your shoulders muscles to tire from constantly
supporting your outstretched arm, leading to neck and shoulder pain. Keeping it close to your
keyboard means you won't have to overstretch when reaching for the mouse.

2. Keep your mouse close to your keyboard.

Placing your mouse on a desk if your keyboard is on a tray can cause you to overreach, and
result in shoulder or neck pain. You should be able to use your mouse comfortably with your
arms close to your side, and your elbows at a slightly "open" angle.

3. Consider a mouse tray to help keep your mouse near your keyboard.

Your mouse should be close to your keyboard, and both should be comfortably placed. If you are
using a keyboard tray, the best position for your mouse is on an adjustable tray that slides over
the numeric keypad of your keyboard, putting your mouse about 2 inches above your keyboard
(known as a mouse bridge). If your keyboard tray has a tiltable mouse tray to the side, then try
angling it down slightly to improve your wrist posture. Try to avoid using a mouse to the side of
the keyboard on a flat, lowered tray, because this puts your hand in greater wrist extension.

4. Adjust your mouse/trackball's software controls.

Many people don't realize that the way their mouse functions can be controlled through software.
You can adjust the speed at which your mouse moves, the time required between double-clicks,
and the size of the cursor. If you're constantly having to backtrack because you shot past the
"close window" button, try slowing your mouse down.

5. Consider using a different input device to reduce repetitive arm motions.

Trackballs decrease the distance your shoulder has to travel, which may help reduce movement-
related pain. (However, they can also put more strain on the fingers and hands.) Some mouse
designs work like a joystick and may help. You can also use a touch pad, a pen and tablet, or a
foot-operated mouse. Try a variety of devices, and use the one that feels most comfortable.

6. Make sure you're using the right size pointing device.
People often don't realize that mice may come in different sizes. Make sure that the mouse fits

comfortable in your hand; if it's too large, you may want to find a smaller mouse. There are even
adjustable-size mice.



Mouse Maneuvers — Website List

Mousercise

http://www.pbclibrary.org/mousing/mousercise.htm

Mouserobics

http://www.ckls.ore/~crippel/computerlab/tutorials/mouse/page 1 .html

Mouse Practice

hitp://www.unc.edu/depts/recreate/spot/activity/computer/mouse/page3 .html

Scrolling Practice

http://www.unc.edw/depts/recreate/spot/activity/computer/mouse/scroll2.html

Deal or No Deal

http://www.nbc.com/Deal or No Deal/game

Other Simple Mouse Games

http://www.pbclibrary.org/mousing/games.htm

Box Game

http://www.southcote.net/community centre/boxesgame.htm

World Mouse Clicking Championships

htto://www.urban75.com/Mag/iava7 html




Mouse Maneuvers -- Tips for Healthy Mouse Use

1 . Use your elbow-not your wrist-to move the mouse

Keeping your forearms in one place and using your wrists to "flick" the mouse can increase
intracarpal pressure-leading to wrist and finger pain.

2. Limit the amount you use your tracking device

Take breaks every 15-20 minutes and change your position frequently.

3. Use keyboard shortcuts

Many of the commands available through menu choices can also be accomplished by using the
keyboard. (For example, Ctrl-C can be used to copy text.) These shortcuts can significantly
reduce the amount you need to move your mouse

4. If you surf the web or edit long documents, consider a mouse with a scroll wheel

Scrolling with a wheel instead of the entire mouse helps reduce repetitive arm motions

5. Don't click too hard!

Just like typing on a keyboard, some people tend to use excessive force when clicking the mouse
or trackball buttons. A light touch will do-and it will help save your hands and wrists!

6. Make sure you're holding your mouse correctly

Believe it or not, there's a right and a wrong way to hold your mouse. Here are a few tips to help:
Avoid letting your fingers "hover" above the mouse or trackball buttons. Some people are always
"poised and ready" to click, holding their fingers over the button even when they're not using it.
This causes unnecessary stress on your fingers. When you're not ready to click, you don't need

your fingers raised-give them a rest by letting them relax or lay gently on the button.

Use a light grip. Just like typing too hard on a keyboard, holding your mouse too tightly can lead
to pain. Don't choke your mouse, it's already dead!

Don't hold the mouse when you're not using it. Some people seem glued to their mouse. If there's
a short period where you won't be using your mouse, you don't need to hold onto it.

Keep your wrists in a straight or "neutral” position. Avoid tilting (up and down) or angling (side
to side) your wrists.

7. Try using your other hand to operate the mouse

Switching hands, or "load sharing,” limits the amount that each hand has to work. It may seem
strange, but it takes most people just a few days to get used to the change.

8. If you use a trackball, consider placing padding or a rest under your elbow

This can help reduce the work your shoulder performs in keeping your arm raised. Make sure
you use different fingers to operate the trackball-using just your thumb can lead to discomfort.



March 5, 2010

Ms. Lisa Adkins

Ohio Historic Preservation Office
1982 Velma Avenue

Columbus, Ohio 43211-2497

Dear Lisa:

The TLCPL Kent Branch Library project involves Interior and exterior renovations of an existing Library in
the Inner ¢ity of Toledo. Majority of work involved consists of extensive site and Interlor renovation
work, but it is important to also note there is minimal work to be done on the exterlor of the building as
well as enclosing an existing courtyard. The square site borders West Central Ave. and Collingwood
Blvd. and consists of the existing library, a parking lot, and minimal landscaping. The 106 review project
summary form has been started but further assistance is needed in completing it.

The Toledo Lucas County Publie Library and myself look forward to successfully completing this 106
Review and working with the Ohio Historic Preservation Office,  Please feel free to contact me at your
convenience.

With best regards,

Eotlret A,

Edward A. Glowacki, AlA, LEED AP
Buehrer Group Architecture & Engineering, Inc,




QHIQ HISTORICAL SOCTETY
Ohio Historic Presarvafion Office

OHio HisToRIC PRESERVATION OFFICE:
RESOURCE PROTECTION AND REVIEW

Section 106 Review - Project Summary Form

For projects requiring a license from the Federal Communications Commisslon, please use
FCC Forms 620 or 621. DQ NOT USE THIS FORM.

SECTION 1: GENERAL PROJECT INFORMATION
All contact information provided must include the name, address and phone number of
the person listed. Email addresses should also be included, if available. Please refer
to the Instructions or contact an OHPO reviewer (mailto:Section106@ohichistory.org) If
you need help completing this Form, Unless otherwise requested, we will contact the
person submitting this Form with questions or comments about this project.

Date:March 8, 2010
Name/Affiliation of person submitting form:Ed Glowacki / Architect
Mailing Address:314 Conant Street, Maumee, Ohio 43537

Phone/Fax/Email:(419) 893-9021 / (419) 893.9027 /
ed@buehrergroup.com

A. Project Info:

1. This Form provides information about;
New Project Submittal:

YES X NO []

Additional information relating to previously submitted project:
YES [INO

OHPQO/RPR Serial Number from previous submission:

2. Project Name (if applicable):
TLCPL Kent Branch Library Renovations

3. internal tracking or reference number used by Federal Agency, consultant,
and/or applicant to identify this project (if applicable):



B. Project Address or vicinity:
3101 Collingwood Boulevard, Toledo, Ohio 43610

C. City/Township:
Toledo

D. County:
Lucas

E. Federal Agency and Agency Contact. /f you do not know the federal agency
involved in your profect, please contact the parly asking you to apply for Section
106 Review, not OHPO, for this information. HUD Entitlement Communities acting
under delegated environmental review authority should list their own contact
information.

F. Type of Federal Assistance. List all known federal sources of federal funding,
approvals, and permits to avoid repeated reviews.

G. State Agency and Contact Person {if applicable):

H. Type of State Assistance:

[. Is this project being submitted at the direction of a state agency solely under Ohio
Revised Code 149.53 or at the direction of a State Agency? Answering yes lo this
question means that you are sure that ng federal funding, permits or approvals will
be used for any part of your project, and that you are seeking comments only
under ORC 149.53.

YES I No [

J. Public Involvement- Describe how the public has been/will be informed about this
project and its potential to affect historic properties. Please summarize how they
will have an opportunity to provide comments about any effects to historic
properties. (This step is required for all projects under 36 CFR § 800.2);

K. Please list other consulting parties that you have contacted/will contact about this
project, such as Indian Tribes, Certified Local Governments, local officials, property
owners, or preservation groups. (See 36 CFR § 800.2 for more information about
involving other consuiting parties). Please summarize how they will have an
opportunity to provide comments:

SECTION 2: PROJECT DESCRIPTION AND AREA OF POTENTIAL EFFECTS (APE)
Provide a description of your project, its site, and geographicai information. You will also
describe your project’s Area of Potential Effects (APE). Please refer to the Instructions or
contact an OHPO reviewer if you need help with developing the APE or completing this form.,




For challenging projects, provide as much information as possible in all sections, and then
check the box in Section 5.A. to ask OHPQ to offer preliminary comments or make
recommendations about how to proceed with your project consultation. This is recommended
if your project involves effects to significant historic properties or if there may be challenging
procedural issues related to your project. Please note that providing information to complste
all Sections will still be required and that asking OHFO for preliminary comments may tend to
delay completion of the review process for some projects.

A. Does this project involve any Ground-Disturbing activity: YES X NO [J
(If Yes, you must complete all of Section 2.A. If No, proceed directly to Section 2. B.)

1. General description of width, length and depth of proposed ground disturbing
activity:

2. Narrative description of previous land use and past ground disturbances, if known:
3. Narrative description of current land use and conditions:

4. Does the landowner know of any archaeological resources found on the property?
YES [ NO [X] It yes, please describe:

B. Submit the exact project site location on a USGS 7.5-minute topographic quadrangle map
for all projects. Map sections, photocopies of map sections, and online versions of USGS
maps are acceptable as long as the location is clearly marked. Show the project's Area of
Potential Effects (APE). It should be clearly distinguished from other features shown on the
map:

1. USGS Quad Map Name:

2. Township/City/Village Name:

C. Provide a street-level map indicating the location of the project site; road names must be
identified and legible. Your map must show the exact location of the boundaries for the
project site. Show the project’'s Area of Potential Effects (APE). It should be clearly
distinguished from other features shown on the map:

D. Provide a verbal description of the APE, including a discussion of how the APE wil include
areas with the potential for direct and indirect effects from the project. Explain the steps
taken to identify the project's APE, and your justification for the specific boundaries
chosen:

E. Provide a detailed description of the project. This is a critical part of your submission. Your
description should be prepared for a cold reader who may not be an expert in this type of
project. The information provided must help support your analysis of effects to historic
properties, not other types of project impacts. Do not simply include coples of
environmental documents or other types of specialized project reports. I there are muitiple
project alternatives, you should include information about all alternatives that are still under
active consideration:



SECTION 3: IDENTIFICATION OF HISTORIC PROPERTIES
Describe whether there are historic properties located within your project APE. To make that
determination, use information generated from your own Background Research and Field
Survey. Then choose one of the following options to report your findings. Please refer to the
Instructions and/or contact an OHPO reviewer if you are unsure about how to identify historic
properties for your project.

If you read the Instructions and you're still confused as to which reporting option best fits your
project, or you are not sure if your project needs a survey, you may choose to skip this
section, but provide as much supporling documentation as possible In all other Sections, then
check the box in Section 5.A. to request preliminary comments from OHPO. After re viewing
the information provided, OHPO will then offer comments as to which reporting option is best
suited to document historic properties for your project. Please note that providing information
to complete this Section will still be required and that asking OHPO for preliminary commenits
may tend to delay completion of the review process for some projects.

jround Research and Field Survey:

Recording the Results of Back

A. Summary of discussions and/or consuttation with OHPO about this project that
demonstrates how the Agency Official and OHPO have agreed that no Field Survey was
necessary for this project (typically due to extreme ground disturbance or other special
circumstances). Please attach coples of emalils/correspondence that document this
agreement. You must explain how the project’s potential to affect both archaeological and
historic resources were considered.

B. A table that includes the minimum information listed in the OHPO Section 106
Documentation Table (which is generally equivalent to the information found on an
inventory form). This information must be printed and mailed with the Project Summary
Form. To provide sufficient information to complete this Section, you must also include
summary observations from your field survey, background research and eligibility
determinations for each property that was evaluated in the project APE.

C. OHI (Ohio Historic inventory) or OAI (Ohlo Archaeologlcal Inventory) forms- New or
updated Inventory forms may be prepared using the OHI pdf form with data population
capabilities, the Internet IForm, or typed on archival quality inventory forms, To provide
sufficient information to complete this Section, you must include summary chservations
from your field survey and background research. You must also inciude eligibllity
determinations for each property that was evaluated in the project APE

D. A historic or archaeologlcal survey report prepared by a qualified consultant that meets
professional standards. The survey report should meet the Secretary of the Interior's
Standards and Guidelines for Identification and OHPO Archaeological Guidelines. You
may also include new inventory forms with your survey, or update previous inventory
forms. To complete this section, your survey report must include summary observations
from your field survey, background research and eligibility determinations for each
property that was evaluated within the APE.

E. Project Findings. Based on the conclusions you reached in completing Section 3, please
choose one finding for your project. There are (mark one):
[7] Historic Properties Present in the APE:
] No Historic Properties Present in the APE:



SECTION 4: SUPPORTING DOCUMENTATION

This information must be provided for all projects.

A.

C.

Photographs must be keyed to a street-level map, and should be included as
attachments to this application. Please label ali forms, tables and CDs with the
date of your submission and project name, as identified in Section 1. You must
present enough documentation to clearly show existing conditions at your project
site and convey details about the buildings, structures or sites that are described in
your submission. Faxed or photocopled photographs are not acceptable. See
Instructions for more info about photo submissions or 36 CFR § 800.11 for federal
documentation standards.
1. Provide photos of the entire project site and take photos to/from historic
properties fromAowards your project site to support your determination of
effect in Section 5.
2. Provide current photos of all buildings/structures/sites described.
Project plan, specifications, site drawings and any other media presentation that
conveys detailed information about your project and its potential to affect historic
properties.
Copies or summaries of any comments provided by consulting parties or the
public,

SECTION 5: DETERMINATION OF EFFECT

A. Request Prellminary Comments. For challenging projects, provide as much

information as possible in previous sections and ask OHPQ to offer preliminary
comments or make recommendations about how to proceed with your project
consultation. This is recommended If your project involves sffects to significant
historic properties, if the public has concerns about your project’s potential to affect
historic properties, or if there may be challenging procedural issues related to your
project. Please be aware that providing information in all Sections will still be
required and that asking OHPO for preliminary comments may tend to delay
completion of the review process for some projects.

1. We request preliminary comments from OHPO about this project;

YES A Nno ]

2. Please specify as clearly as possible the particular issues that you would
like OHPO to examine for your project {for example- help with developing
an APE, addressing the concerns of consulting parties, survey
methodology, etc.):

Determination of Effect. If you belleve that you have gathered enough
information to conclude the Section 106 process, you may be ready to make a
determination of effect and ask OHPO for concurrence, while considering public
comments. Please select and mark one of the following determinations, then
explain the basis for your decision on an attached sheet of paper:

[ No historic properties will be affected based on 36 CFR § 800.4(d) (1).
Please explain how you made this determination:

[] No Adverse Effect [36 CFR § 800.5(b)] on historic properties. This finding
cannot be used if there are no historic properties present in your project
APE. Please explain why the Criteria of Adverse Effect, [36 CFR Part
800.5(a) (1)), were found not to be applicable for your project:



[J Adverse Effect [36 CFR § 800.5(d) (2)] on historic properties. Please
explain why the criteria of adverse effect, [36 CFR Part 800.5(a) (1)], were
found to be applicable to your project. You may also include an explanation
of how these adverse effects might be avoided, reduced or mitigated:

Please print and mail completed form and supporting documentation to:

Chlo Historic Preservation Office
Attn: Mark J. Epstein, Department Head
Resource Frotection and Review
1982 Velma Avenue
Columbus, OH 438211-2497



U.S. Fish & Wildlife Species List

Groupl iaEE i e NG e . sormie s Popiilation: e T adakis S Cead Office ! HikiIRedovery Plan Name 55 5 | Recovery PlanStage
Birds Arctic Peregrine Falcon {Falco Recovery

Birds Bald eagle {Haliaeetus lower 48 States Recovery Rock Istand Ecological Services [Southwester Bald Eagle Final

Birds Plping Plover (Charadrius Great Lakes watershed Endangered East Lansing Ecological Recovery Plan for the Great Final

Clams catspaw (Eplablasma obliquata |AL; Free-Flowing Reach of the |Experimental Population, Non-  |Office Of The Regional Ditector

Clams Rayed Bean (Villosa fabalis) Candidate Columbus Ecological Services

Flowering Plants Eastern Prairie Fringed crchid Threatened Chicago Ecological Services Eastern Praitie Fringed Crchid  [Final

IInsects Karner Blue butterfly (Lycaeides Endangered Green Bay Ecological Services |Recovery Plan for the Kamer  |Final

Mammals Indiana bat (Myotis sodalis) Endangered Blocmington Ecological Indiana Bat (Myotis sodalis) Draft Revision 1

Reptites Eastern M, 1ga (Sistrurus Candidate Chicago Ecological Services




Species Profile for Indiana bat (Myotis sodalis) Page [ of 4

Species Profile

Environmental Conservation Online System

{http:/iwww. fws. gov)
Indiana bat (Myotis sodalis)

Kingdom: Animalia Class: Mammalia Order: Chiroptera
Family: Vespertilionidae

Listing Status: Endangered

Quick links: Federal Register (#status) Recovery (#recovery)
Critical Habitat (#crithab) Conservation Plans
{#iconservationPlans) Petitions (#petitions) Life History

{#lifeHistory) Other Resources (#other)

General Information

The Indiana bat is a medium-sized myotis, closely resembling the little brown bay (Myotis lucifugus) but differing
i coloration. lts fur is a dull grayfish chestnut rather than bronze, with the basal portion of the hairs of the back
dult lead colored. This bat's underparts are pinkish to cihnamon, and its hind feet smaller and more delicate than
in M. lucifugus. The calcar (heel of the foot) is strongly keeled.

Lead Region: Great Lakes-Big Rivers Region (Region 3) (http:/fwww.fws.qovimidwest/)
Date l.isted: Mar 11, 1967

States/US Territorles in which the Indiana bat is known fo occur: Arkansas
{IspeciesProfile/profile/countiesByState.action2entityid=18state=Arkansas) , Connecticut

{(/speciesProfile/profile/countiesByState action?entityld=18&state=Connecticut} , Georgia

(IspeciesProfile/profile/countiesByState.action2entityld=18&state=Georgial , Hlinois

{{speciesProfile/profile/countiesByState.action?entityld=18&state=lllincis} , Indiana
{{speciesProfile/profile/countiesByState action?entityld=18&state=indiana) , lowa
{/speciesProfile/profile/countiesByState.action?entityld=18state=lowa) , Kentucky

{IspeciesProfile/profile/countiesByState.action Zentityld=1&state=Kentucky) , Marvland
{IspeciesProfile/profile/countiesByState.action ?entityld=18&state=Maryland} , Michigan
{IspeciesProfile/profile/countiesByState.action ?entityld=1&state=Michigan} , Mississippi
{lspeciesProfile/profile/countiesByState.action7entityld=1&state=Mississippi) , Missouri
{{speciesProfile/profile/countiesByState.action?entityld=18state=Missouri) , New Jersey

{lspeciesProfile/profile/countiesByState.actionPenfityld=1&state=New Jersey} , New York

{IspeciesProfile/profile/countiesByState.action?entityld=18state=New York) , North Carolina
{/speciesProfile/profile/countiesByState.action?entityid=1&state=North Carolina} , Qhio

(/speciesProfile/profile/countiesByState.action ?entityld=1&state=0hio) , Oklahoma

{{speciesProfile/profile/counties ByState.actionZentityld=18&state=0klahoma) , Pennsylvania

(/speciesProfile/profilelcountiesByState.actionZentityld=18state=Pennsylvania) , Tennessee

http://ecos.fivs.gov/speciesProfile/profile/speciesProfile.action?spcode=A000 3/5/2010



Species Profile for Indiana bat (Myotis sodalis) Page 2 of 4

(!speciesProfile/profile/countiesByState.action Pentitvld=18&state=Virainia) , West Virginia
{ispeciesProfile/profile/countiesByState.action?entityld=1&state=West Virginia}

US Counties in which the Indiana bat is known to cccur: View Al
IspeciesProfile/profile/countiesBySpecies.action?entityld=1

USFWS Refuges in which the Indiana bat is known to occur: BIG MUDDY NATIONAL FISH AND
WILDLIFE REFUGE , BIG OAKS NATIONAL WILDLIFE REFUGE , CLARKS RIVER NATIONAL
WILDLIFE REFUGE , CROSS CREEKS NATIONAL WILDLIFE REFUGE , CYPRESS CREEK
NATIONAL WILDLIFE REFUGE ... Show All Refuges {tavascript:foggieRefuges('on’)

» Federal Register Documents

Most Recent Federal Register Documents {Showing 5 of 6 : view all
(fspecuesProfilelproflleldtspiavAllDocuments'fedreq actaon?spcode—AOOO))

Citatron Page Title

Draft Indlana Bat Recoverv Pian F;rst Rev:swn Draft Survev Protocol
04/16/2007|72 FR 19015 19016 |{http:/ifrwebgate.access.qpo.govicgi-bin/getdoc.cqi?
dbname-ZDGT remster&doctd-fﬂﬁapﬂ? 120}

90 Day and 12-Month Findings on a Petition To Rev&se Cr|t|cat Habltat for

03/06/2007(72 FR 9913 9917 ithe Indiana Bat (http:/ifrwebgate.access.apo.govicgi-bin/getdoc.cqi?
dbname-ZGO? re 1ster&domd frOSerT 21

EndanCiered and Threatened erdllfe and Plants In|t|ation ofa 5-Year

Review of Curtis’ Pearlymussel and Indiana Bat

{hitp:/ffrwvebgate.access.gpo.govicgi-bin/getdoc.cqi?

W&l

Determination of Critical Habitat for Amer[can Crocodtle Calrfornla

Condor, Indiana Bat, and Florida Manatee; 41 FR 41914 (American

09/24/1976/41 FR 41914 crocodile, Crocodylus acutus, California condor, Gymnogyps

californianus: Indiana bat, Myotis sodalis; Florida manatee, Trichechus
manatus) {http:flecos. fws qovldocslfederal reqisten’frﬂ 5 pdﬂ

00/21/2006171 FR 55212 55214

Proposed Determmatlon of Critical Habltat for Snail Darter Amertcan
Crocodile, Whooping Crane, California Condor, Indiana Bat, and Florida
12/16/197540 FR 58308 58312)Manatee; 40 FR 58308 58312 {Percina (Imostoma) sp., Crocodyius acufus
Grus americana, Gymnogyps californicus, Myotis sodalis, Trichechus

manatus) (http://fecos.fws.govidocs/federal register/frg3.pdf

» Recovery

Recovery Plan Information Seargh (/rear/pub/ConfigureRecActionReport.do?path=ROAR Custom
Queries.Public Actions AdHoc)
* Information Search FAQs (http:fiwww.fws.aoviendangered/recovery/ROAR FAQs%2008-05-

09 FINAL pdf

Current Recovery Plan(s)

‘ Tltle I Plan Actlon Status o fPEan Sta
| ana Bat (Mvohs sodalas} Draft Recoverv VleW imptementatmn Progress Draft

04/16/2007iP]an. First Revision {frear/pub/planimplementationStatus.action? L
’“ as ar iE 1 [N e = ey K alaleie faTat] jReV!Slon

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=A000 3/5/2010
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.,D,ate c.taﬂonpage g oo e "'}."me et e Documeng Type :

Draft indiana Bat Recovery Pian, First Revision;, Draft . Nottce Draft
04/16/2007{72 FR 18015 19016{Survey Protocol (http:/ifrwebgate.access.qpo.qovicai- Recovery Plan
inlgetdoc cg!?dbname-Z{)O? register&docid=fr1 BaEOT 1201 Availability
Endangered and Threatened Wildlife and Plants;
- * iNofi X
09/21/2006171 ER 55212 55214 Initiation of a 5-Year Review of Gurtis’ Pearlymussel otice 5-year

and Indiana Bat (http:/ifrwebgate. access.gpo.govicgi- Review, Initiation

bin/getdoc. cgi?dbname=2006 reqister&.docid=fr21se06-63}

Review
Title

09/29/2009 Indlana bat completed 5-vr revaew Udocslf;ve year rev:ewldoczsz‘f pdf}

Current Critical Habltat Documents (Showing 2 of 2 )
Tltle

. Determmation of Cr:tlcal Habttat for Amencan
Crocodile, California Condor, Indiana Bat, and
Florida Manatee; 41 FR 41914 (American

09/24/1976141 FR 41914 crocodile, Crocodylus acutus, California Final Rule Active

condor, Gymnogyps californianus; Indiana bat,
Myotis sodalis; Florida manatee, Trichechus
manatus)

(httg Hecos fws govldocslfederat reglsterlfr115 Qdﬂ

Proposed Determmatlon of Crltical Habitat for
Shail Darter, American Crocodile, Whooping

Crane, California Condor, indiana Bat, and
Florida Manatee; 40 FR 58308 56312 (Percina Not

12/16/1875/40 FR 58308 58312 — Proposed Rule X
imostoma) sp., Crocodylus acutus, Grus Required

americana, Gymnogyps catifornicus, Myotis
isodalis, Trichechus manatus)
{http://ecos.fws.qovidocsifederal register/fr83.pdf

To learn mare about critical habitat please see http://eriticalhabitat.fws.qov (hitp:/fcriticathabitat. fws.gov)

. ﬁaté Cltatlon Page

Ipocument Type| status

» Conservation Plans

Habitat Conservation Plans (HCP) {iearn more {/does/conservation _plansfHCP Incidental Take.pdf))
(Showmg 1 of 1 )

HCP Plan Summarles r
Slx Pomts Road Interchanqe {http Hecos fws qovlconserv Dlanslserv}ethov doi. hcp servlets PIanReport?

iplan_id=12248regio ) P&rtype=1)

» Petitions

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=A000 3/5/2010
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Date e Citation Page e e e K'll‘it[e' e, i Fmdmg :

Sman N IO N .  Notica 12 ':nonth
90-Day and 12-Month Findings on a Petition To Revise petition finding,
Critical Hahitat for the Indiana Bat Not warranted

03/06/2007{72 FR 9913 8917

(http:/ifrwebgate.access.gpo.govicgi-binfgetdoc.cgi? * iNotice 90-day
dbname=2007 reqister&docid=fri6mr07-21} Petition Finding,

Not substantial

» Life History

No Life History information has been entered into this system for this species.
» Other Resources

NatureServe Explorer Species Reports (javascript:;) -- NatureServe Explorer is a source for authoritative

conservation information on more than 50,000 plants, animals and ecological communtities of the U.S and
Canada. NatureServe Explorer provides in-depth information on rare and endangered species, but includes
common plants and animals too. NatureServe Explorer is a product of NatureServe in collaboration with the
Naiural Heritage Network.

ITIS Reports (javascript:y) - ITIS (the integrated Taxonomic Information System) is a source for authoritative
taxonomic information on plants, animals, fungi, and microbes of North America and the world.

l.ast updated: March 5, 2010

FWS Endangered Home {http://iwww.fws goviendangered/) | ECOS Home {lecos public/) | Contact Us

{lecos/heipdesk.do?version=SPECIES PROFILE-1 2 23}

http://ecos.fivs.gov/speciesProfile/profile/speciesProfile.action?spcode=A000 3/5/2010
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Species Profile

Environmental Conservation Online System

{http:ifwww. fws.gov)
Piping Plover (Charadrius melodus)

Kingdom: Animalla Class: Aves Order: Ciconiiformes
Family: Charadriidae

Listing Status: Endangered and Threatened

Quick finks: Federal Register {#status) Action Plans
(#actionPians) Recovery {firecovery) Critical Habitat (#crithab)

Conservation Plans {ficonservationPlans) Petitions {#petitions)

Life History (#lifeHistory) Other Resources {#other)

General Information

Size: 18 cm (7.25 in) in length. Color: Breeding season: Pale brown above, lighter below; black band across
forehead; bill orange with black tip; legs orange; white rump. Male: Complete or incomplete black band encircles
the body at the breast. Female: Paler head band; incomplete breast band. Winter coloration: Bill black; all birds
lack breast band and head band.

Population detail

The FWS is currently monitoring the following populations of the Piping Flover

» Population location: Great Lakes watershed in States of IL, IN, MI, MN, NY, OH, PA, and Wl and
Canada (Ont.}
Listing status: Endangered
States/US Territories in which this population is known to occur: Illinois
{{speciesProfile/profile/countiesByState.action 7entityld=1308state=|llinois) , Indiana
{{speciesProfile/profile/countiesByState.action?entityld=1308state=Indiana) , Michigan
{{speciesProfile/profile/countiesByState.action Zentityld=130&state=Michigan) , Minnesotfa

{IspeciesProfile/profilefcountiesByState.action?entityld=130&state=Minnesota) , New York

{/speciesProfile/profile/countiesByState.action7entityld=130&state=New York) , Chio

{/speciesProfile/profile/countiesByState.actionPentityld=1308&state=Chio) , Pennsylvania

{/speciesProfile/profile/countiesByState.action?entityld=1308&state=Penngylvania} , Wisconsin
{fspeciesProfile/profile/countiesByState. action Pentityld=1308&state=Wisconsin}

US Counties in which this population is known to cccur: View All
{/speciesProfile/profile/countiesBySpecies.action?entityld=130)

USFWS Refuges in which this population is known to ocour: AMAGANSETT NATIONAL
WILDLIFE REFUGE , ELIZABETH ALEXANDRA MORTON NATIONAL WILDLIFE REFUGE
FERGUS FALLS WETLAND MANAGEMENT DISTRICT , MORRIS WETLAND MANAGEMENT

MIASTAIIAT TAOATT MO KTATIARLATL YANLD BRI e isre

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B079 3/5/2010



Species Profile for Piping Plover (Charadrius melodus) Page 2 of 6

For more information: http:/fecos.fws.govidocs/life histories/B079.htmi
(http:/lecos.fws.qovidoes/life _histories/B079.html)

+ Population location: Entire, except those areas where listed as endangered above

Listing status: Threatened

States/US Territories in which this population is known to occur: Alabama
{fspeciesProfile/profile/countiesByState. action?entityld=131&state=Alabama) , Colorado
{{speciesProfile/profile/countiesByState.action 7entityld=131&state=Coloradoe} , Connecticut
{IspeciesProfile/profile/countiesByState.action?entityld=1318state=Connecticut) , Delaware
IspeciesProfile/profile/countiesByState.action?entityld=1318&state=Delaware) , Florida
{ispeciesProfile/profile/countiesByState.action 2entityld=1318&state=Fiorida) , Georgia
{IspeciesProfila/profile/countiesByState.action Pentityld=1318state=Georgia} , Indiana
{/speciesProfile/profile/countiesByState.action?entityld=1318&state=indiana) , lowa

{/speciesProfile/profile/countiesByState.action Pentityld=1318state=lowa) , Kansas

{lspeciesProfile/profile/countiesByState.action ?entitvld=131&state=Kansas) , Kentucky
{!speciesProfile/profile/countiesByState.action?entityld=131&state=Kentucky) , Louisiana

(fspeciesProfile/profile/countiesByState.action?entityld=131&state=Louisiana) , Maine
(/speciesProfile/profile/countiesByState.action 7entityld=131&state=Maine) , Maryland
{{speciesProfile/profife/countiesByState.action?entityld=131&state=Maryland} , Massachuseits
{/speciesProfile/profile/countiesByState.action7entityld=1318&state=Massachusetts) , Minnesota
{!speciesProfile/profile/countiesByState.action?entityld=131&state=Minnesota)} , Mississippi
{{speciesProfile/profile/countiesByState.action?entityld=1318state=Mississippi} , Missouri

{/speciesProfile/profile/countiesByState.action Pentityld=131&state=Missouri} , Montana
{/speciesProfile/profile/countiesByState.action Pentityld=131&state=Montana) , Nebraska
{lspeciesProfile/profile/countiesByState.action 2entifyld=131&state=Nebraska) , New Hampshire
{lspeciesProfile/profile/countiesByState. action Pentityld=1318&state=New Hampshire) , New Jersey
{ispeciesProfile/profile/countiesByState.action?entityld=131&state=New Jersey) , New Mexico
IspeciesProfile/profile/countiesByState action?entityid=1318&state=New Mexico) , New York
{fspeciesProflie/profile/countiesByState.action ?entityld=131&state=New York) , North Carolina
{/speciesProfite/profile/countiesByState.action?entityld=1318state=North Carolina) , North Dakota

{(/speciesProfile/profile/countiesByState.action?entityld=131&state=North Dakota) , Ohio
{/speciesProfile/profile/countiesByState.actionPentityld=131&state=0hio} , Qklahoma
{/speciesProfile/profile/countiesByState.action?entityld=1318state=0Okiahoma} , Puerto Rico
(fspeciesProfile/profitelcountiesByState.actionZentityld=1318&state=Puerto Rico} , Rhode Island
{ispeciesProfile/profile/countiesByState.actionTentityld=1318state=Rhode Island} , South Carolina
{/speciesProfile/profile/countiesByState.action?entityld=131&state=South Carelina} , South Dakota
{{speciesProfile/profilelcountiesByState. actiontentityld=131&state=South Dakota} , Texas
{lspeciesProfile/profile/countiesByState. action ?entityld=131&state=Texas} , Virginia
(IspeciesProfile/profile/countiesByState.action?entityld=131&state=Virginia) , Wisconsin
{lspeciesProfile/profile/countiesByState.action?entityld=131&state=Wisconsin) , Wyoming
{IspeciesProfile/profile/countiesByState.action Zentityld=1318state=Wyoming)

US Counties in which this population is known to occur: View All
{/speciesProfile/profile/countiesBySpecies.action?entityld=131}

USFWS Refuges in which this population is known to occur: ANAHUAC NATIONAL WILDLIFE
REFUGE , ARANSAS NATIONAL WILDLIFE REFUGE , ARROWWQOD NATIONAL WILDLIFE
REFUGE , AUDUBON NATIONAL WILDLIFE REFUGE , AUDUBON WETLAND MANAGEMENT
DISTRICT ... Show All Refuges (javascript:togaleRefuges{'on')

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B079 3/5/2010
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For more information: http://ecos.fws.gov/docs/life histories/B079.html

{http:/lecos.fws, govidocs/life histories/B078 htmi}

Current Listing Status Summary

Status ” D..afe E;iefed o l.ead Region . Where Llsted

Endangered 12/11/1985 |2reat Lakes-Big R*V?rs Region (Region 3) Great Lakes watershed
(http:l!ww_w._fws_.q_ovlmldwestl) B -
Northeast Region (Redion 5) except Great Lakes

Threatened 12/11/1985 (http:ﬂwww.fws.qovlnortheast!) watershed

» Federal Register Documents

Most Recent Federal Register Documents (Showing 5 of 28 : view ail
B ) UspemesProﬁlelprof Ie!d;splavAIiDocumentslfedreq action?spcode-BO?Q))
Date Cltatlon Page Title

Rewaed Deslqnation of CrltlcaE Habltat for the Wmtermq Populatlon of
the Piping Plover {Charadrius melodus) in Texas
{hitp:llfrwebgate.access.gpo.govicgi-binfaetdoc.cqi?
dbname=2009 re |ster&doc1d fr19m 09 12
Revised Desmnat!on of Crltlcaf Habltat for the Wmtermq Popuiatlon of
the Piping Plover (Charadrius melodus} in North Carolina; Final Rule
hitp://frwebgate.access.apo.govicqi-binfaetdoc.cgi?

dbname—~2008 re lster&docld fr210c08 8
Endanqered and Threatened W:idllfe and P[ants 5-Year Rewew Notlce
of initiation of review; request for information on the piping plover
Charadrius melodus). {hitp:/lirwebgate.access.gpo.govicgi-bin/getdoc.cgi?

dbname-zooa req:ster&doctd fr30$e08 89)
Correctlon to Revised Desrqnatlon of Critical Habltat for the Wmtennq
Population of the Piping Plover (Charadrius melodus) in Texas
http:/ffrwebgate.access. gpo.govicai-bin/getdoc.cqi?

dbname=2008 re !ster&domd fr09 n08 107
Rewsed Desmnatlon of Cntlcai Habitat for the Wlnterlnq ?opulatlon of

05/20/2008.73 FR 29293 29321 the Piping Plover (Charadrius melodus} in Texas: Proposed rule.

(http:/ifrwebgate.access.gpo.gov/cgi-binfgetdoc.cai?
dbname=2008 reqister8docid=fr20my08-27)

05/19/2009:74 FR 23475 23600

10/21/2008|73 FR 62815 62841

09/30/2008/73 FR 56860 56862

06/09/2008{73 FR 32629

» Action Plans

_ Action Plans (Showing 1 of 1) S
Date I Title
10/01/2009’Great Lakes pipmq plover spotllqht sgemes actlon glan {Idocslactmn Eiansfdoc3033 pdﬂ

» Recovery

Recovery Plan information Search (/roar/pubiConfigureRecActionReport.do?path=ROAR Custom

Queries.Public Actions AdHoc)

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B079 3/5/2010
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« [nformation Search FAQSs (http:/iwww.fws.qoviendangeredirecovery/ROAR FAQs%2008-05-

09 FINAL.pdf}
- S Current Recovery Plan(s)
Date |  Tite '  Plan Action Status.
. G.f.éét.Lékes.& Northern Greafi Piams F’mquew lmplementatmn Proqress
(5/12/1988:Plover ({roar/pubiplanimplementationStatus.action?|Final

(hltp Ilecos fws qov.’doosfrecoverv pEan.'880512 pdﬂ document!d 1002549}

Piping Plover Atlantic Coast Populatlon erw [mpiementation Proqress
05/02/1996|Revised Recovery Plan {{roar/pub/planlmplementationStatus.action?

;httg Hecos fws govldocslrecovem glan.’960502 pdf) documentld 1000797)

Recovery Plan for the Great Lakes gogu[atlo Vlew Implementatlon Proqress

09/16/2003|of Piping Plovers {roar/pub/planimplementationStatus,action?/Final

(http Hecos fws qovldocslrecoverv plan/030916a.pdf); mmnj_@_u!_,__m“mma

' Other Recovery Documents (Showing 5 of 6 : view all (IspecnesProfnlelprof:leldasplavAllDocumentsl
_otherRecovery. actlon?§pcode-BO7Q)}

Final
Revisio

Date | Citation Page Title | Document Type
Endanqered and Threatened W:Id!lfe and P[ants 5~Year
Review - Notice of initiation of review: request for + |Notice 5-year
09/30/2008{73 FR 56860 56862|information on the piping plover (Charadrius melodus). . e
Review, Initiation
{hitp:iffrwebgate.access.qpo.govicai-bin/getdoc.cgi?
dbname—-z{ma requster&doc:d fraoseGB 89)

) Approved Recovem Plan for the Great Lakes P|gmg . Notice Finair
098/16/2003168 FR 54241 54242|Plover (Charadrius melodus) Recovery Plan

(http llecos fws. qov!docs.ffederal reqlster.'fr4176 pdf) Availability

) Notice of Availahility of the Plglng Plover gCharadrlu .
= iNotice Draft

melodus) Great Lakes Popula
08/05/2002167 FR 50687 50688 melodus} Great Lakes Population Draft Recovery Plan
for Review and Comment

(hitp:llecos fws.govidocs/federal registerffride2 pdf)
» |Notice Dogc.
ETWP: Proposed Designation of Critical Habitat for the |Availability
Northern Great Plains Breeding Population of the Piping|Notice Reopen

Recovery Plan
Availability

12/28/2001|66 FR 67165 67166/Plover; Reopening of Public Comment Period and Comment
Notice of Availability of Draft Economic Analysis + IProposed Critical
{http:flecos.fws.govidocs/federal register/fr3830.pdf} Habitat, Critical

habitat--birds
Reopening of Comment Period and Notice of \
Notice Doc.
Availability of Draft Economic Analysis on Proposed A
Availability

09/19/2000,65 FR 56530 56531|Critical Habitat Designation for the Great Lakes

Breeding Population of the Piping Plover
(htt;) Hecos fws. qow’docsifederal remsterlfr3648 pdf)

Date Title
09."29/2009 Pipmq Plover (Charadrlus meiodus} 5-Year Rewaw (ldocslfwe _year rewewldoc3009 pdf)

Notice Reopen
Comment

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B079 3/5/2010
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» Critical Habitat

Current Critical Habitat Documents (Showing 5 of 12 : view all {(fspeciesProfile/profile/displayAliDocuments!
- Date (.:ita.ﬁ.f;ﬁ”i.’.age Title Docdment Typé Stétus
e T Crltlca! Habltat cor the il Mot

Wintering Popuylation of the Piping Plover
05/19/2009{74 FR 23475 23600 {Charadrius melodus) in Texas Final Rule Active

{http:/firwebgate.access.gpo.govicgi-binfaetdoc.cqi?
dbname=2009 requster&domd fr19my09 12)
Revised Designation of Crlttcai Habitat for the
Wintering Population of the Piping Plover
i i ina: \ Not
10/21/2008173 FR 62815 62841 {Charadrius meiodus) In North Carolina: Final Final Rule '
Rule (htip:ifirwebyate.access. gpo.govicqi- Required
bin/getdoc.cgi?
7 dbname“2008 reqlster&cfomd fr21oc08 8)
Rewsed Des:q_nation of Crmcal Habitat for the
Wintering Popuiation of the Piping Plover
06/20/2008(73 FR 29293 29321|[Charadrius melodus) in Texas: Proposed rule, |Proposed Rule
(http:/lfrwebqate.access.apo.qovicai-binfgetdoc.cgi?
dbname=2008 reqaster&docud fr20mv08-27)

Endangered and Threatened Wildlife and F'Eants.

iDesignation of Critical Habitat for the Northern Not
09/11/2002/67 FR 57637 57717|Great Plains Breeding Population of the Piping |Final Rule

Not
Required

- Required
Plover; Final Rule
{http Hecos fws qovldocslfederai reqlsterlfr3943 pdf)
ETWP Proposed Designation of Critical Habitat
for the Northern Great Plains Breeding

i ipi : i Not
12/28/2001/66 FR 67165 67166|-2ulation of the Piping Flover, Reopening.of | o pyjq ,

Public Comment Period and Notice of Required

Availability of Draft Economic Analysis
(http:/ecos.fws.qovidocs/federal register/fr3830.pdf)

To learn more about critical habitat please see hitp://criticalhabitat.fws.qov (hitp:/icriticaihabitat.fws.gov)

» Conservation Plans

Habitat Conservation Plans {(HCP) (learn more {/docsiconservation ptans/HCP Incidental Take.pdf))
{Showing3of3)

‘ HCP Plan Summaries

Ma ic Car et Woods Assomaflon htt Hecos fws ovlconserv ians.’servletl ov. d0| hc sarvlets PIanRe ort?
glan |d 1075&reg|on“3&tyge“HCP&rtyQ }

Plplnq PEover HCP (State of Massachusetts)

hitp:llecos.fws.qov/conserv plans/serviet/gov.doi.hep.serviets.PlanRaport?
plan_id=3758region=5&type=HCP&rtype=1}

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B079 3/5/2010
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Hcp p]an summa ries S

Volusia Beaches (http://ecos.fws.qoviconserv plans/servietigoy.doi.hep.serviets.PianReport?
Iplan_ig=31918region=4Atype=HCP&rtype=1)

» Petitions

No petition findings have been published for the Piping Plover.

» Life History

No Life History information has been entered into this system for this species.
» Other Resources

NatureServe Expiorer Species Reports {javascript:;) -- NatureServe Explorer is a source for authoritative

conservation information on more than 50,000 plants, animals and ecological communtities of the U.S and
Canada. NatureServe Explorer provides in-depth information on rare and endangered species, but includes
common plants and animals too. NatureServe Explorer is a product of NatureServe in collaboration with the
Natural Heritage Network.

ITES Reports (javaseript:;) - {TIS (the Integrated Taxonomic Information System) is a source for authoritative
taxonomic information on plants, animals, fungi, and microbes of North America and the world.

Last updated: March 5, 2010

FWS Endangered Home {hitp:/iwww.fws.oviendangered’) | ECOS Home (fecos public/) | Contact Us
{fecosihelpdesk.do?version=SPECIES PROFILE-1 2 23)

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B079 3/5/2010
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Species Profile

Environmental Conservation Online System

{http:/iwww.fws.dov)
Eastern Massasauga (Sistrurus catenatus

catenatus)

Kingdom: Animalia Class: Reptilia Order: Squamata
Family: Viperidae

Listing Status: Candidate

Quick links: Candidate Info {#candidate) Federal Register
{#status) Conservation Plans {#conservationPlans] Petitions
(#petitions) Life History {#iifeHistory] Other Resources (fother)

General Information

Massasaugas are small snakes with thick bodies, heart-shaped heads and vertical pupils. The average length of
an adult is about 2 feet. Aduit massasaugas are gray or light brown with large, light-edged chocolate brown
blotches on the back and smaller blotches on the sides. The snake's belly is marbled dark gray or black and
there is a narrow, white siripe on its head. Its tail has several dark brown rings and is tipped by gray-yellow
horny raitles. Young snakes have the same markings, but are more vividly colored. The head is a triangular

shape and the pupils are vertical.

Lead Region: Great Lakes-Big Rivers Region (Region 3) (hitp:/iwww.fws.govimidwest/)

States/US Territories in which the Eastern Massasauga is known to occur: llinois
{/speciesProfile/profile/countiesByState.action?entityld=7800&state=lilinois) , Indiana
{/speciesProfllelprofile/countiesByState.action7entityld=78008state=indiana) , lowa
(lspeciesProfiie/profile/countiesByState.action?entityld=78008state=lowa) , Michigan
{{speciasProfile/profile/counties ByState.action Pentityld=78008state=Michigan} , Minnesota
{{speciesPrefile/profile/countiesByState .action7entityld=78008state=Minnesota) , Missouri
(fspeciesProfile/profile/countiesByState action7entityld=78008state=Missouri) , New York
{IspeciesProfile/profile/countiesByState.actionPentityld=78004&state=New York) , Qhio

{/speciesProfile/profile/countiesByState.action?entityld=7800&state=0hio} , Pennsylvania
{/speciesProfile/profile/countiesByState.action 7entityld=78008&state=Pennsylvania) , Wisconsin

{lspeciesProfile/profile/countiesBySiate.action?entityld=7800&state=Wisconsin)

US Counties in which the Eastern Massasauga is known to ocour: View All
{{speciesProfile/profile/countiesBySpecies.action?entityld=7800)

Countries in which the the Eastern Massasauga is known to occur; Canada

For more information: htip://www.fws.gov/midwest/Endangered/reptifes/eama-fct-sht.html
{http:/l'www.fws.govimidwest/Endangered/reptiles/eama-fct-sht.html)

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=C03P
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» Candidate Information

Current Candidate Status

Listing Priority: 8

Magnitude:

Moderate to Low

Immediacy: Imminent
Taxonomy: Subspecies/population

Species Assessment Form for the Eastern Massasauga -- 85Kb,
{http:/lecos.fws.qovidocsicandforms pdffr3/C03P VO1.pdf

Candidate Notice of Review Documents (Showing 5 of 10 : view all

Usp_eclesProfilelgrofl}eidlsglaMAI!Documents‘cnor action?sgcode-CGSPl)

C|tation Page

11/08/2009

12/10/2008

74 FR 57803 57878

73 FR 75175 75244

TItle
Rewew of Natlve Sgecles That Are Candldates for Listmg as Endangered

or Threatened; Annual Notice of Findings on Resubmitted Petitions:

Annual Description of Progress on Listing Actions

hitp:iHrwebgate.access. apo.qovicqi-bin/getdoc.cgi?

dbname-2009 regxster&docld fr09n009-23)

Review of Natlve Species That Are Candldates for Llstmq as Endanqered

12/06/2007

09/12/2006

06/11/2005

72 FR 69033 69106

71 FR 53755 53835

70 FR 24869 24934

dbname“2008 reqlster&domd fr10de08 26)
Rewew of Natwe Species That Are Candtdates for Listing as Endangered

or Threatened: Annual Notice of Findings on Resubmitted Petitions;
Annual Description of Progress on Listing Actions: Proposed Rule

{http:/ffrwebgate.access.gpo.govicgi-bin/getdoc.cqi?

or Threatened: Annual Notice of Findings on Resubmitted Petitions:

Annual Description of Progress on Listing Actions: Proposed Rule

dbname-ZOD'( reqlster&domd frOBdeO?-ZD)

htip:/ffrwebgate.access.apo.govicai-binigetdoc.cqi?

Rewew of Natwe Species That Are Cand:dates ar Proposed for Lrstlnq as

bname 2008 reglster&domd fr125905~281

Endanaered or Threatened; Annual Notice of Findings on Resubmitted

Petitions; Annual Description of Progress on Listing Actions

hitp:/ifrwebgate.access.apo.govicgi-bin/getdoc.cqi?

Endanqered and Threatened Wildlife and Plants Rev;ew of Natwe
Species That Are Candidates or Proposed for Listing as Endangered or
Threatened; Annual Notice of Findings on Resubmitted Petitions; Annual
Description of Progress on Listing Actions; Proposed Rule

(http:/fecos.fws.govidocsifederal register/frd410.pdf)

» Federal Reglster Documents

“ .E.)“a.te. | Cltatlon Page

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=C03P

Most Recent Federal Register Documents (Showing 5 of 10 : view all
UspemesProfﬂelpmﬂleldlsplavAilDocumentsffedreq act;on‘?spcode COSP))

Tltle

'Re\new of Natwe Sgemes That Are Candldates for Listing as Endangered !

Page 2 of 4
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Date

12/10/2008

12/08/2007

Citation Page Title

. , e
dbname=2009 reqister&docid=fr09no09-23)
Review of Native Species That Are Candidates for Listing as Endangered
or Threatened; Annual Notice of Findings on Resubmitted Petitions;
73 FR 75175 75244|Annual Description of Progress on Listing Actions; Proposed Rule
http:/frwebgate.access.apo.govicgi-bin/getdoc.cai?

dbname=2008 reaister&docid=fri0de)8-26)
Review of Native Species That Are Candidates for Listing as Endangered
or Threatened; Annual Notice of Findings on Resubmitted Petitions;
72 FR 69033 69106jAnnual Description of Progress on Listing Actions: Proposed Rule
{hitp:/ffrevebgate.access.gpo.govicyi-binfgetdoc.coi?
dbname=2007 register&docid=fr06de07-20)

09/12/2006

05/11/2005

Review of Native Species That Are Candidates or Proposed for Listing as
Endangered or Threatened; Annual Notice of Findings on Resubmitted
71 FR 537565 53835Petitions; Annual Description of Progress on Listing Actions
(hito:/ifrwebgate.access.gpo.govicai-bin/getdoc.cgi?

dbname=2006 register&docid=fri2se06-28)
Endangered and Threatened Wildlife and Plants: Review of Native
Species That Are Candidates or Proposed for Listing as Endangered or
70 FR 24869 24934|Threatened; Annual Notice of Findings on Resubmitted Petitions: Annual
Description of Progress on Listing Actions: Proposed Rule
{hitp:/fecos.fws.govidocsifederal register/fr4410.pdf}

» Action Plans

Da..te. —

Eastern massasauga action plan (/docs/action plans/doc2989.pdf

... Action Plans (Showing 1of1)

» Conservation Plans

Candidate Conservation Agreements with Assurances (CCAA}: {learn more
doos/conservation plans/CCAANonFederalpdf)) (Showing1of1)

CCAA Plan Summaries 7 i

Eastern .rr‘\.égéasauqa raitlésnéke CCAA for Rome State Nature Presefvé; AshtabuIaCounty. 6Hio o

f{htlp:Hecos,fws.qoviconserv plans/serviet/gov.doi.hcp.serviets. PlanRepori? l
lplan d=3836&region=38type=CCAAGrtype=1) |

» Petitions

No petition findings have been published for the Eastern Massasauga.

» Life History

No Life History information has been entered into this system for this species.

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=C03P 3/5/2010
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» Other Resources

NatureServe Explorer Species Reports {iavascript:;) -- NatureServe Explorer is a source for authoritative

conservation information on more than 50,000 plants, animals and ecological communtities of the U.S and
Canada. NatureServe Explorer provides in-depth information on rare and endangered species, but includes
common plants and animals too. NatureServe Explorer is a product of NatureServe in collaboration with the
Natural Heritage Network,

ITIS Reports {javascript:;) - ITiS {the Integrated Taxonomic Information System) is a source for authoritative
taxonomic information on plants, animals, fungi, and microbes of North America and the world.

Last updated: March 5, 2010

FWS Endangered Home (http:/iwww fws.gov/endangered/) | ECOS Home (fecos _public/} | Contact Us
{fecos/helpdesk.do?version=SPECIES PROFILE-1 2 23}

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=C03P 3/5/2010



Species Profile for Karner Blue butterfly (Lycaeides melissa samuelis) Page 1 of 4

Species Profile

Environmental Conservation Online System

{http:/lwww.fws.gov)
Karner Blue butterfly (Lycaeides melissa

samuelis)

Listing Status: Endangered

Quick links: Federal Reqgister {#status} Action Plans

{#actionPlans) Recovery (#recovery) Critical Hahitat (#crithab)
Conservation Plans {#conservationPlans) Petitions {#petitions)
Life History {#iifeHistory} Other Resources (#other}

Lead Region: Great Lakes-Big Rivers Region (Region 3)
(hitp: ilwww . fws. govimidwest/)
Date Listed: Dec 14, 1992

States/US Territories in which the Karner Blue butterfly is known to occur: lilinois
{{speciesProfile/profile/countiesByState action?entityld=420&state=lllinois) , Indiana
{IspeciesProfilelprofiie/countiesByState.actionPentityld=4208state=indiana) , Michigan
{fspeciesProfile/profile/countiesByState.action?entityld=4208state=Michigan) , Minnesota

{/speciesProfile/profile/countiesByState.action Zentityld=4208state=Minnesota) , New Hampshire

{IspeciesProfile/profile/countiesByState.actionPentityld=420&state=New Hampshire} , New York
{/speclesProfile/profile/countiesByState.action?entityld=4208state=New York) , Ohio
{IspeciesProfile/profile/countiesByState. action ?entityld=420&state=0Ohio} , Wisconsin
{/speciesProfile/profile/countiesByState action 7entityld=420&state=Wisconsin)

US Counties in which the Karner Blue bulterfly is known to occur: View All

{/speclesProfile/profife/countiesBySpecies.action?entityld=420)
USFWS Refuges in which the Karner Blue butterfly is known to ocour: LEOPOLD WETLAND

MANAGEMENT DISTRICT , NECEDAH NATIONAL WILDLIFE REFUGE , ST. CROIX WETLAND
MANAGEMENT DISTRICT
Countries in which the the Karner Blue butterfly is known to occur: Canada

» Federal Register Documents

Most Recent Federal Register Documents {(Showing 6 of 7 : view all
_ UspeciesProfile/profile/displayAllDogumentsifedreg.action?spcode=100F))

Date Citation Page Title

Notice of initiation of review; request for information on nine listed

03/18/2000{74 FR 11600 11602|Midwestern species (hitp:/ffrwebgate.access.gpo.govicgi-bin/getdoc.cgi?
dbname=2009 register&docid=fr18mr09-76)

Proposed Low Effect Habitat Conservation Pian for Michigan Electric

02/22/2005/70 FR 8602 8603 I'E'ransmission Company, LLC (httn://frwebgate.access.gpo.govicgi-

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=I100F 3/5/2010



Species Profile for Karner Blue butterfly (Lycaeides melissa samuelis)

; ..,.Date .

09/19/2003

12/05/2001

1271411992

c|tat;on Page e e e e e
Nohce of Avallabllltv of the Approved Recoverv Pian for the Karner Blue

68 FR 54813 54914

66 FR 63248 63249

57 FR 69236 59244

» Action Plans

10."0‘1 /2009

Date

- Tltle

Page 2 of 4

Butterfly {Lycasides melissa samuelis)

(http Ifecos fws qovldocslfederai reqisten'fr4178 pdﬂ

Notlce of Avallabiht of the Karner Blue Butterfly (Lycaeides me!i.ssa
samuelis) Technical/Agency Draft Recovery Plan for Review and

Comment (h!tp Hecos fws qovldocslfederal reqlsterlfr3827 pciﬂ

ETWP Determmatlon of Endanqered Status for the Karner Blue Butterflv.

57 FR 59236 53244 (http:flecos fws.qov/docs/federal register/fr2183.pdf)

Action Plans (Showing 1 of 1)

Title

Karner blue butterﬁv spothqht specles actlon plan {Idocslactton plans.’doc3035 pdf)

» Recovery

Recovery Plan Infermation Search {/roar/pub/ConfigureRecActionReport.do?path=ROAR Custom

Queries.Public Actions AdHoc)
+ Information Search FAQs (http:/fwww.fws.gov/endangeredirecovery/ROAR FAQs%2008-05-

. Document Type”

* |Notice Draft

Notice 5-year
Review, Initiation

- |Notice Final
Recovery Plan
Availability

Recovery Plan
Availability

09 FINAL.pdf)
o Current Recovery Plan(s) S
Date Title Plan Actlon Status |Plan Stat
V E
Recovery Plan for the Karner Blue Butterfly e lmp ementatlon Proqress \
09/19/2003 {{roar/publ/planimplementationStatus.action?:Final
{htip:/fecos.fws.govidocs/recovery plan/0309192.pdf)
documentld 700007) _
_ - '_'.Other Recovery Documents (Showmg 3 of 3 )
Date Citataon Page Tltle

Notlce of mltrahon of review; request for mformatlon on

03/18/2009/74 FR 11600 11602 nine listed Midwestern species .
(http:iffrwebgate.access.apo.govicgi-bin/getdoc.cgi?
dbname-2009 req:ster&docld fr18mr09-76)
Notice of Avallabllltv of the Anproved Recoverv Plan for

09/19/2003|68 FR 54913 54914|the Karner Blue Butterfly (Lycaeides melissa samuelis)
{http: Ilecos fws qov.’docslfederal reqlsten’fr4178 pdﬂ
Notice of Avaatabllstv of the Karner Blue Bufterfly

12/05/2001166 FR 63248 63249 {Lycaeides melissa samuelis) Technical/Agency Draft
Recovery Plan for Review and Comment
{h__tt;a:h’ecos.fv.l_s.qovldocs_lfederal register/fr3g27.pdf

» Critical Habitat

Current Critical Habitat Documents (Showing 20f2)

http://ecos. fws.gov/speciesProfile/profile/speciesProfile.action?spcode=I00F

3/5/2010



Species Profile for Karner Blue butterfly (Lycaeides melissa samuelis) Page 3 of 4

Date c.tatlonpage e e e et et T]ﬂe e i e e D,oc.um.ent ,Ty,pe status

Proposed Endanqered or Threatened Status
07/03/1978:43 FR 28038 28945|with Critical Habitat For Ten Butterflies or Moths Proposed Rule |Active
(hitp:flecos.fws.govidocs/federal reqister/fr224.pdf}

Proposed Endangered or Threatened Status
07/03/1978,43 FR 28938 28945|with Critical Habitat For Ten Butterflies or MothsiProposed Rule
7 (btlp:I.'eoos.f\.vs‘qowrdocslfecieral register/fr224.pdf)

Not
Required

To learn more about critical habitat please see http://criticalhabitat.fws.gov (http:leriticalhabitat. fws.qov)

» Conservation Plans

Habitat Conservation Plans (HCP) {learn more (/docs/conservation plansiHCP Incidental Take.pdf])
(Showing 5 of 5 )

. HCP Plan Summanes S

Cobb to Brickyard Reconductoring Project
htip:llecos.fws.goviconserv plans/serviet/gov.doi.hep.serviets.PlanReport?
plan_id= 3645&reqion—3&tvpe-HCP&rtvpe-‘!)

Michigan Statewide Karner hiue butterfly HCP

{hitp:/lecos.fws.qoviconserv plans/serviet/gov.doi.hcp.serviets.PlanReport?

plan |d 1227&req10n-3&tvpe-HCP&rtype—1)

NIPSCO {(hitp:llecos.fws.qoviconserv plans/serv!eﬂqov doE hcp servlets PIanReport?
g[an ad 3423&regton"a&tme*HCP&rtyg =1}

State-W[de Karner Blue/Wisconsin DNR
{http://fecos.fws.qoviconserv_plans/servliet/gov.doi.hep.serviets. PlanReport?

plan_id= 273&reqion-3&tvpe HCP&rtvpe-ﬂ

Town of Rome (hitp:lfecos.fws. gow’consew pians/serviet/qov.doi.hcp.serviets. PlanReport?
Dlan id 271&reqion-3&tvoe-HCP&rtvpe—-1)

Safe Harbor Agreements (SHA) (Iearn more Udocsfconservation ptanslSafeHarbor odﬂ) (Showmg 1 of1 )
SHA Plan Summanes

Indiana Karner blue butterfly SHA (http .Uecos fws c;ovlconserv pfanslservlethov doi hop servlols PIanReport?
plan id=1229&reglon=3&type=SHAS&ype=1)

» Patitions

No petition findings have been published for the Karner Blue butterfly.

» Life History

Mo Life History information has been entered into this system for this species.

» Other Resources

NatureServe Explorer Species Reports {javascript:;) -- NatureServe Explorer is a source for authoritative
conservation information on more than 50,000 plants, animals and ecological communtities of the U.S and

Canada. NatureServe Explorer provides in-depth information on rare and endangered species, but includes
romman nlante and animals tan NatiraServe Fynlarer ic a nendiict nf NatiireQernve in enllaharatinn with the

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=100F 3/5/2010
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ITIS Reports (javascript:;) -- ITIS (the Integrated Taxonomic Information System) is a source for authoritative
taxonomic information on plants, animals, fungi, and microbes of North America and the world.

Last updated: March 5, 2010

FWS Endangered Home (hitp:/fwww.fws.qoviendangered/) | ECOS Home (fecos public/) | Contact Us
{fecosthelpdesk.do?version=SPECIES PROFILE-1 2 23)

http://ecos. fws.gov/speciesProfile/profile/speciesProfile.action?spcode=I00F 3/5/2010
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Species Profile

Environmental Conservation Online System

{hitpiwww.fws.gov}

Rayed Bean (Villosa fabalis)

Kingdom: Animalia Class: Bivalvia Order: Unionoida
Family: Unionidae

Listing Status: Candidate

Quick links: Candidate Info (#candidate) Federal Register
(#status) Conservation Plans (#conservationPlans) Petitions

(#petitions) Life History (#iifeHistory) Other Resources (#iother)

Lead Region: Great Lakes-Big Rivers Region {Region 3}

{bttp:/fwww.fws.govimidwest/)

States/US Territories in which the Rayed Bean is known to

occur; Indiana {/speciesProfile/profile/countiesByState.action?entityld=60628&state=Indiana) , Michigan
{{speciesProfile/profile/countiesByState.action?entityld=60628&state=Michigan)} , New York
{/speciesProfile/proflle/countiesByState.action Pentityld=60628&state=New York} , Ohio
{IspeciesProfile/profile/countiesByState.action?entityld=6062&state=Chio) , Pennsylvania
{/speciesProfile/profife/countiesByState.action?entityld=60628 state=Pennsylvania} , Virginia
{fspeciesProfile/profile/countiesByState.action?entityld=6062&state=Virginia)

US Countles in which the Rayed Bean is known to oceur: View All
(IspeciesProfile/profile/countiesBySpecies.action?entityld=6062)

Countries in which the the Rayed Bean is known to occur: Canada

» Candidate Information
Current Candidate Status

Listing Priority: 2
Magnitude: High
Irmmediacy: Imminent
Taxonomy: Species
Species Assessment Form for the Rayed Bean -- 114Kb.
{http:/lecos.fws.gov/docs/candforms pdfir3/F01A 101.pdf)
Candidate Notice of Review Documents {(Showing 5 of 10 : view all

{{speclesProfile/profile/displayAllDocumentsicnor.action?spcode=F01A)}

' Citation Page Title
Review of Native Species That Are Candidates for Listing as Endangered
or Threatened; Annual Notice of Findings on Resubmitted Petitions;

11/09/2009i74 FR 57803 57878)Annual Description of Progress on Listing Actions

— bate o

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=F01 A 3/5/2010
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VDVaie "'C'ita't'fon Page e Title I
Review of Native Specnes That Are Candldates for Listing as Endanqered

or Threatened; Annual Notice of Findings on Resubmitied Petitions;

12/10/2008,73 FR 75175 75244|Annual Description of Progress on Listing Actions; Proposed Rule
(http:/ffrwebgate.access.gpo.govicgi-bin/getdog.cai?

dbname-zoﬂa reqlster&domd-fr10de08 26)
Review of Natwe Species That Are Candrdates for Llstmq as Endanqered
or Threatened; Annual Notice of Findings on Resubmitted Petitions;
12/06/200772 FR 69033 89106iAnnual Description of Progress on Listing Actions; Proposed Rule
{http:/lfrwebgate,access.gpo.gov/cgi-bin/getdoc.cqi?
dbname=2007 register&docid=fr06de07-20)

Review of Native Species That Are Cand;dates or Proposed for Lfstmq as

Endangered or Threatened: Annual Notice of Findings on Resubmitted
09/12/2006/71 FR 53755 53835|Petitions; Annual Description of Progress on Listing Actions

http:/ffrwebgate.access.apo.govicgi-binlgetdoc.cqi?

dbname"ZOOG roglstor&docld fr125906-281
Endangered and Threatened Wildlife and Piants, Rewew of Natw
Species That Are Candidates or Proposed for Listing as Endangered or
05/11/2005{70 FR 24869 24934|Threatened; Annual Notice of Findings on Resubmitted Petitions: Annual

Description of Progress on Listing Actions; Proposed Rule

{htip:llecos.fws.govidocs/federal register/frd410.pdf)

» Federal Register Documents

Most Recent Federal Register Documents (Showing 5 of 10 : view all
(IspeclesProflIelprofileldIsptavAlfDocumentslfedreq actlon?spcode'FO‘EA})

Dé'to Cltatton Page Title
Review of Native Sgemes That Are Candldates for i_lst;ng as Endangered

or Threatened; Annual Notice of Findings on Resubmitted Petitions;

11/09/200874 FR 57803 57878)Annual Description of Progress on Listing Actions
(http:/ifrwebdate.access.gpo.gov/cgi-bin/getdoc.cqi?

dbname—ZOOQ reqister&domd fr09n009-23}
Review of Natwe Species That Are Candldates for Llstmq as Endanqered
or Threatened; Annual Notice of Findings on Resubmitted Petitions;
12/10/2008|73 FR 75175 75244 Annual Description of Progress_on Listing Actions; Proposed Rule
{hitp:/ifrwebgate.access.apo.govicgi-bin/getdoc.cal?
dbname“2008 reqlster&domd“fr‘i()de(]ﬁ 26)
Rewew of Natwe Species That Are Candtdates for Llstmq as Endanqered
or Threatened; Annual Notice of Findinas on Resubmitted Petitions;
12/08/2007|72 FR 69033 69106]Annual Description of Progress on Listing Actions; Proposed Rule
{hitp:/ifrwebgate.access.gpo.gov/cgi-binfgetdoc.cgi?

dbname—-ZOO? register&docid= frOBdeGT-ZO\
Review of Native Species That Are Cancfidates or Proposed for Llstmq as
Endangered or Threatened; Annual Notice of Findings on Resubmitted
09/12/2006i71 FR 53755 53835|Petitions; Annual Description of Progress on Listing Actions
{http://frwebgate. access.apo.govicgi-bin/getdoc.cgl?

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=F01A 3/5/2010



Species Profile for Rayed Bean (Villosa fabalis)

05/11/2005\70 FR 24869 24934

 Citation Page |

Tit[e
Endangered and Threatened Wildiifé and F.‘Iant.s.; Réviéw of .r-s..lét.ive

Species That Are Candidates or Proposed for Listing as Endangered or
Threatened; Annual Notice of Findings on Resubmitted Petitions; Annual

Page 3 of 3

» Conservation Plans

No conservation plans have been created for Rayed Bean

» Petitions

No petition findings have been published for the Rayed Bean.

» Life History

Description of Proaress on Listing Actions; Proposed Rule
{http:/lecos.fws.qovidocs/federal register/fr4410.pdf)

No Life History information has been entered into this system for this species.

» Other Resources

NatureServe Explorer Species Reports {javascript:;) -- NatureServe Explorer is a source for authoritative

conservation information on more than 50,000 plants, animals and ecological communtities of the U.S and

Canada. NatureServe Explorer provides in-depth information on rare and endangered species, but includes
common plants and animals too. NatureServe Explorer is a product of NatureServe in collaboration with the
Natural Heritage Network.

iT1S Reports {javascript:;) -- ITIS (the Integrated Taxonomic Information System) is a source for authoritative
taxonomic information on plants, animals, fungi, and microbes of North America and the world,

Last updated: March 5, 2010

FWS Endangered Home (htip:/fwww.fws.goviendangered/) | ECOS Home {lecos public/) | Contact Us

(lecosihelpdesk.do?version=SPECIES PROFILE-1 2 23}

http://ecos.fivs.gov/speciesProfile/profile/speciesProfile.action?spcode=F01 A 3/5/2010
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Species Profile

Environmental Conservation Online System

{http:/fwww fws.gov)
Eastern Prairie Fringed orchid

(Platanthera leucophaea)

Kingdom: Plantae Class: Liliopsida Order: Orchidales
Family: Qrchidaceae

Listing Status: Threatened

Quick links: Federa! Reqister (#istatus) Recovery (#recovery)
Critical Habitat (#crithab) Conservation Plans
(#conservationPlans) Petitions (#petitions) Life History

{#lifeHistory} Other Resources (#other)

Lead Region: Great L.akes-Big Rivers Region {Region 3) (hitp: ffwww.fws.govimidwest()
Date Listed: Ssp 28, 1989

States/US Territories in which the Eastern Prairie Fringed orchid is known to ocour: Arkansas
IspeciesProfile/profile/countiesByState. action ?entityld=984 &state=Arkansas} , llinois

{/speciesProfile/profile/countiesByState.action?entityld=9848state=lllinois) , Indiana
» lowa
{lspeciasProfile/profile/countiesByState.action Pentityid=984&state=lowa) , Maing
{{speciesProfile/profils/countiesByState. action Pentityld=9848&state=Maine) , Michigan

IspeciesProfile/profile/countiesByState.action2entityld=084&state=Indiana

{/speciesProfile/profile/countiesByState.action 7entityld=984&state=Michigan) , Qhio
IspeciesProfile/profile/countiesByState.action 7entityld=984&state=0hio) , Oklahoma
{lspeciesProfile/profile/countiesByState action ?entityld=9848state=0klahoma) , Virginia
{/speciesProfile/profile/countiesByState action?entityld=084&state=Virginia} , Wisconsin
lspeciesProfitefprofile/countiesByState.action?entityld=9848&state=Wisconsin
US Counties in which the Eastern Prairie Fringed orchid is known to occur: View All
{/speciesProfile/profife/countiesBySpecies.action ?entityld=984)

USFWS Refuges in which the Eastern Prairie Fringed orchid is known to occur: CEDAR POINT
NATIONAL WILDLIFE REFUGE , LEOPOLD WETLAND MANAGEMENT DISTRICT , OTTAWA
NATIONAL WILDLIFE REFUGE

Countries in which the the Eastern Prairie Fringed orchid is known to occur: Canada

» Federal Register Documents

Most Recent Federal Register Documents (Showing 3of3)
Date | Citation Page | Title |

Initiation of 5-Year Reviews of Three Wildlife 8pecies and Two Plant I
Species in the Midwest Region {hitp://frwebaate.access.apo.govicyi- |

07/27!2007'72 FR 41348 41350

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=Q2GG 3/5/20160



Species Profile for Eastern Prairie Fringed orchid (Platanthera leucophaea) Page 2 of 3

e Date S cltat'on page S

Title

09/28/1989/54 FR 39857 39863

(hitp:/lecos.fws.qovidocs/federal register/fr1602.pdf)

ETWP; Determinaﬁ&n 6f Threatened Status for Easiern and Western
Prairle Fringed Orchids; 54 FR 39857 39863

Proposal {o Determine Platanthera leucophaea {Eéstem Prairie Fri.nqe.d .
Orchid) & Plantanthera praeclara (Western Prairie Fringed Orchid) to be

10/11/198853 FR 39621 39626

Thr. Species; 53 FR 39621-39626

» Recovery

(http:/lecos.fws.govidocs/federal register/fr1494.odf}

Recovery Plan Information Search (frear/pub/ConfigureRecActionReport.do?path=ROAR Custom

Querles.Public Actions AdHoc)

« Information Search FAQs (http://www fws.qoviendangeredirecovery/ROAR FAQs%2008-05-

09_FINAL.pdf)
... Current Recovery Plan(s) e
- VDater Title Plan Action Status 'Plan Stz
. . . View Implementation Progress
Eastern Prairie Fringed Orchid - . .
09/29/1999 htto:/lecos. fws. aovidocs/racove 1an/990925 1 {froar/pub/planlmplementationStatus.action?|Final
L’"E'“‘m“g'"—"'"""““""'ﬂ“p‘““‘“““ﬁ‘ﬂ_ o documentid=100028}
Other Recovery Documents (Showing 1 of 1) e
Date Citation Page Title Document Type
Initiation of 5-Year Reviews of Three Wildlife Species
ies | i i + Notice 5-
07/27/2007172 FR 41348 41350 and Two Plant Species in the Midwest Region 0 |'ce Y‘.%"f‘r‘ !
(hitp:/lfrwebgate.access.qpo.govicgi-bin/getdoc.cqi? Review, Inittation

» Critical Hahitat

dbname=2007 register&docid=fr27jy07-71}

No critical habitat rules have been published for the Eastern Prairie Fringed orchid.

» Conservation Plans

No conservation plans have been created for Eastern Prairie Fringed orchid

» Petitions

No petition findings have been published for the Eastern Prairie Fringed orchid.

» Life History

No Life History information has been entered into this system for this species.

» Other Resources

http://ecos. fiws.gov/speciesProfile/profile/speciesProfile.action?spcode=Q2GG 3/5/2010
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commeon planis and animals too. NatureServe Explorer is a product of NatureServe in collaboration with the
Natural Heritage Network.

{TIS Reports (javascript:;) -- ITIS (the Integrated Taxonomic Information System) is a source for authoritative
taxonomic information on plants, animals, fungi, and microbes of North America and the world.

[ ast updated: March 5, 2010

FWS Endangered Home (http:/iwww.fws.goviendangered() | ECOS Home {lecos public/) | Contact Us
{/fecos/helpdesk.do?version=SPECIES PROFILE-1 2 23}

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=Q2GG 3/5/2010
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Species Profile

Environmental Conservation Online System

(I_l!tp:.’lwww.fws._qov) .
Arctic Peregrine Falcon (Falco peregrinus

tundrius)

Kingdom: Animalia Class: Aves Order: Ciconiiformes
Family: Falconidae

Listing Status: Recovery -

Gra*

Quick links: Federal Reqister (#stafus) Recovery (#recovery)
Critical Habitat (#crithabh) Conservation Plans

{#conservationPlang) Petitions (#petitions) Life History
(#lifeHistory) Other Resources (#other)

Lead Region: Alaska Region {Redion 7) (hitp://alaska.fws.gov/)
Date Delisted:

States/US Territories in which the Arctic Peregrine Falcon is known to accur; Alabama
{lspeciesProfile/profile/countiesByState.action?entityld=2581&state=Alabama) , Alaska
ispeciesProfile/profile/countiesByState.action?entityld=2581&state=Alaska) , Arizona
IspeciesProfile/profile/countiesByState.action 7entityld=25818&state=Arizona) , Arkansas
{/speciesProfile/profile/counties ByState.action ?entityld=2581&state=Arkansas) , California
{IspeciesProfile/profite/countiesByState.action ?entityld=25818&state=California) , Colorado
(IspeciesProfite/proflle/countiesByState action Pentityld=25818&state=Colorado) , Connecticut
({speciesProfile/profile/countiesByState.actionPentityld=25818&state=Connecticut} , Delaware
{{speciesProfile/profile/countlesByState.action?entityld=2581& state=Delaware) , District of Columbia

{IspeciesProfile/profile/counties ByState.actionZentityld=25818&state=District of Columbia) , Florida
{lspeciesProfile/profile/countiesByState.action?entityld=2581&state=Florida) , Georgia
{speciesProfile/profile/countiesByState.actton?entityid=2581&state=Georgia) , Hawaii
(IspeciesProfile/profile/countiesByState action?entityld=25818&state=Hawaii) , ldaho

{ispeciesProfile/profile/countiesByState.action 2entityld=2581&state=ldaho) , Hllinois
{IspeciesProfilelprofile/countiesByState action 2entityld=2581 &state=lllinols) , Indiana
{IspeciesProfile/profile/countiesByState.action Pentityld=25818&state=Indiana) , lowa
{IspeciesProfile/profile/countlesByState.action?entityld=25818&state=lowa) , Kansas
{/speciesProtile/profile/countiesByState.action ?entityld=25818&state=Kansas) , Kentucky
{{speciesProfile/profile/countiesByState.action?entityld=2581 &stale=Kentucky) , Louisiana
IspeciesProfiie/profile/countiesByState action ?entityld=25818&state=Louisiana) , Maine
{{speciesProfile/proflle/countiesByState. action?entityld=25818state=Maine) , Maryland
{{speciesProfile/profile/countlesByState.action?entityld=2581&state=Maryland) , Massachusetts

llenarioePrafilainrafila/anunties RuState antinn?antituld=28R1 R atata=Macaanhinenffel Mirhinan
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{{speciesProfile/profile/countiesByState.action7entityld=2581&state=Minnesota) , Mississippi

{/speciesProfile/profile/countiesByState.action7entityld=25818&state=Misslissippi) , Missouri

IspeciesProfile/profile/countiesByState.action?entityld=2581&state=Missouri) , Montana

{/spectesProfile/profile/countiesByState.action?entityld=2581&state=Montana) , Nebraska

{IspeciesProfile/profile/countiesByState.action ?entityld=2581&state=Nebraska) , Nevada

{IspeciesProfile/profile/countiesByState. action ?entityld=2581&state=Nevada) , New Hampshire
{IspeciesProfile/profile/countiesByState action Zentityld=2581&state=New Hampshire) , New Jersey

(IspeciesProfile/profile/countiesByState.action?entityld=2581&state=New Jersey} , New Mexico

([speciesProfile/profile/countiesByState.action?entityld=25818state=New Mexico) , New York
{/speciesProfile/proflie/countissByState.action?entityld=2581&sstate=New York) , North Carolina
{{speciesProfile/profile/countiesByState. action 7entityld=2581&state=North Carolina} , North Dakota
{fspeciesProfile/profile/countiesByState.action?entityld=2581&state=North Dakota} , Ohio
{/speciesProfile/profile/counties ByState.action?entityld=2581&state=0hio) , Oklahoma
(speciesProfile/profile/countiesByState.action?entityld=25818&state=0klahoma) , Oregon
{IspeciesProfile/profile/counties ByState.action 2entifyid=2581 &state=Qregon) , Pennsylvania
{/speciesProfile/profile/countiesByState.action 2entilyid=25818&sfate=Pennsylvania) , Puerto Rico
{fspeciesProfile/profile/countiesByState.action ?entityld=2581&state=Puerto Rico) , Rhode Island
{IspeciesProfite/profile/countiesByState.action Pentityld=25818&state=Rhode Island) , South Carolina

{/spaciesProfile/profile/countiesByState.action 7entityld=25818&state=South Carolina) , South Dakota
(IspeciesProfile/profile/countiesByState.action?entityld=25818&state=South Dakota) , Tennessee
(/speciesProfile/profile/countiesByState.action?entityld=25818&state=Tennessee) , Texas
([speciesProfile/profile/countiesByState.action ?entityld=2581 & state=Texas) , Litah

{IspeciesProfile/profile/countiesByState action?entityld=2581 &statesUtah) , Vermont
{{speciesProfile/profile/countiesByState.action Pentityld=25818state=Vermont) , Virgin Islands
IspeciesProfile/profile/counties ByState.action?entityld=2581&state=Virgin Islands) , Virginia
{!speciesProfile/profile/counties ByState. action?entityld=25818state=Virginia) , Washington
{IspeciesProfile/profile/countiesByState,action Zentityld=25818&state=Washington) , West Virginia
IspeciesProfile/profile/countiesByState. action?entityld=25818&state=West Virginia) , Wisconsin
{IspeciesProfile/profile/countiesByState.action Pentityld=2581&state=Wisconsin)

US Counties in which the Arctic Peregrine Falcon is known fo occur: View All
{/speciesProfile/profile/countiesBySpecies.action?entityld=2581)

» Federal Register Documents

Most Recent Federal Register Documents (Showing 5 of 9 ; view all
(IsgeclesProflielgrofiEeidasgiayAllDocumentsifedreg achon?sgcode-BMT[)
Date C:tatlon Page Tltle
ETWP Removal of Arctlc Pereqrme Falcon From the Llst of Endanqered
and Threatened W!Edilfe (http llecos.fws. qovldocs!federai reqnsten’fr27‘é4 pdﬂ
ETWP; Proposal to Remove the Arctic Peregrine Falcon From the List of
09/30/1993{58 FR 51035 51045|Endangered and Threatened Wildlife
{httg Hecos.fws. govldocslfecferal regaslen’fr2423 gdﬂ

10/05/189459 FR 50796 50805
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Title
Reclassification of Arctic Peregrine Falcon & Clarification of Status in WA
03/20/1984/48 FR 10520 10526{& Elsewhere in Coterminous US: 48 FR 10520-10526
(http:ifecos.fws.govidocsifederal_register/fr804.pdf)
Proposed Reclassification of Perearine Falcon in No. Amer.; 48 FR §796-
8802 (http:/lecos.fws.govidocs/federal register/fre74.ndf}

B .Ijét.e. Citation Page

03/01/198348 FR 8796 8802

» Recovery

Recovery Plan Information Search {froar/pub/ConfigureRecActionReport.do?path=ROAR Custom
Queries.Public Actions AdHoc)

+ Information Search FAQs (http://www.fws.gov/endangeredirecovery/ROAR FAQs%2008-05-

09 _FINAL pdf

o Other Recovery Documents (Showing 2 of 2) o
Datecuauonpage » : il ;i'itie oo ol A aocumenmpe
Ao F il S WP Remb'val' of Ar(;tic PereqrmeFa|con metha S Moot
10/05/1994|59 FR 50796 50805|List of Endangered and Threatened Wildlife
(httg:.’leco;ﬁ.fwg;_.gﬂ ovidocs/federat reg‘_ui_s_t‘gp_'lfmt?_"lu‘l_4._}g_dﬂ

« [Final Delisting,
Recovered

ETWP: Proposal to Remove the Arctic Peregrine Falcon |Proposed

09/30/1993)58 FR 51035 51045|From the List of Endangered and Threatened Wildlife Delisting,
{http:fecos.fws.qdovidocs/federal register/fr2423.pdf) Recovered

Date Title
Arctic pereqrine falcon PDM plan (incorporated into Final Delisting Rule)
{/docsispecies/doci170.pdf}

10/05/1994

» Critical Habitat

No critical habitat rules have been published for the Arctic Peregrine Falcon.
» Conservation Plans

No conservation plans have been created for Arctic Peregrine Falcon

» Petitions

No petition findings have been published for the Arctic Peregrine Falcon.,

» Life History

No Life History information has been entered into this system for this species.

» Other Resources

NatureServe Explorer Species Reporis (javascript:;) -- NatureServe Explorer is a source for authoritative
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Canada. NatureServe Explorer provides in-depth information on rare and endangered species, but includes
common plants and animals too. NatureServe Explarer is a product of NatureServe in coliaboration with the

Natural Heritage Network,

ITIS Reports {javascript:;) - ITIS {the Integrated Taxonomic Information System) is a source for authoritative
taxonomic information on planis, animals, fungi, and microbes of North America and the world.

Last updated: March 5, 2010

FWS Endangered Home (http://www.fws.gov/endangered/} | ECOS Home (lecos pubiic/} | Contact bis
{lecos/helpdesk.do?version=SPECIES PROFILE-1 2 23)
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Species Profile

Environmental Conservation Online System

{ hltp:llwww.fws.qu)
Bald eagle (Haliaeetus leucocephalus)

Kingdom: Animalia Class: Aves Order: Ciconiiformes
Family: Accipitridae

Listing Status: Threatened and Recovery

Quick links: Federal Redgister (#status) Recovery (frecovery)

Critical Habitat (#crithab) Conservation Plans
(#conservationPlans) Petitions (#petitions) Life History
(#tifeHistoryl! Other Resources {#iother)

General Information

A large raptor, the bald eagle has a wingspread of about 7 fest. Adults have a dark brown body and wings, white
head and tall, and a yellow beak. Juveniles are mostly brown with white mottling on the body, tail, and
undersides of wings. Adult plumage usualiy is obtained by the 6th year. In flight, the bald eagle often soars or
glides with the wings held at a right angle to the body.

Population detail

The FWS is currently monitoring the following poputations of the Bald eagle

* Population location: Sonoran Desert DPS: Arizona: (1) Yavapal, northern Mexico. Gila, Graham, Pinal,
and Maricopa, Counties; and (2) Southern Mohave County (that portion south and east of the center of
Interstate Highway 40 and east of Arizona Highway 95), eastern LaPaz County {that portion east of the
centerline of U.S. and Arizona Highways 95), and north of the centerline of Interstate Highway 8).
Listing status: Threatened

States/US Territories in which this population is known to occur: Arizona
(/speciesProfile/profile/countiesByState.action?entiftyld=9932&state=Arizona) , New Mexico

{lspeciesProfile/profile/countiesByState action?entityld=99328state=New Mexico) , Oklahoma
{fspeciesProfile/profile/countiesByState. action?entityld=99328&state=0klahoma) , Texas

{IspeciesProfile/profile/countiesByState. actionPentityld=9932&state=Texas)

US Counties in which this population is known to occur: View All
{IspeciesProfile/profile/countiesBySpecies.action?entityld=9932}

For more information: http:/fiwww.fws.gov/southwest/es/arizona/BaldEagle.htm

{http:fvrww fws. govisouthwestles/arlzona/BaldEagle. hitin)
+ Population location: U.5.A., conterminous (lower 48) States.
Listing status: Recovery

CtatacllIQ Tarritnriac in which thic naniibatinn e bnasm ta acrure Alahana
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{/speciesProfite/profile/counties ByState.action?entityld=8384&state=Arizona) , Arkansas

{/speciesProfile/profile/countiesByState.action?entityld=8384&state=Arkansas) , California
IspeciesProfile/profile/counties By State.action?entityld=8384&state=California) , Colorado

{IspeciesProflle/profile/countiesByState action?entityid=8384&state=Colorado) , Connecticut

{speciesProfile/profile/countiesByState.action7entityld=8384&state=Connecticut) , Delaware

{/speciesProfile/profile/countiesByState.action?entilyld=83848&state=Delaware) , District of

Columbia (IspeciesProfilelprofile/countiesByState.action?entityld=83848state=District of Columbia) ,

Florida (/speciesProfile/profile/countiesBySiate action?entityld=8384&state=Florida) , Georgia

[specigsProfile/profile/countiesBy$tate.action entityld=8384&state=Georgia) , [daho
{/speciesProfile/profile/countiesByState action?entityld=83848&state=ldaho) , lllinocis

IspeciesProfile/profile/countiesByState.action?entityld=8384&state=
{lspeciesProfile/profile/countiesByState.action?entityld=8384&state=Indiana) , lowa
{IspeciesProfile/profile/countiesByState.action 2entilyld=8384&state~lowa) , Kansas

(IspeciesProfile/profile/countiesByState.action Zentityid=8384&state=Kansas) , Kenfucky
UspeciesProfile/profile/counties ByState. action7entityld=8384&state=Kentucky) , Louisiana

fspecilesProfile/profile/countiesByState.action ?entityld=8384&state=Louisiana) , Maine
{/speciesProfile/profile/counties ByState. action?entityld=8384& state=Maine) , Maryland
{{speciesProfite/profile/countiesByState.actionPentityld=83848state=Maryland) , Massachusetts
{/speciesProfile/profile/countiesByState. action Pentityld=83848state=Massachusetts) , Michigan
{/speciesProfile/profile/countiesByState. action?entityid=83848&state=Michigan} , Minnesoia
{{speciesProfile/profile/countiesByState action?entityld=83848state=Minnesota) , Mississippi
i}, Missouri
IspeciesProfile/profile/countiesByState. action?entityld=8384&state=Missourl) , Montana

(speciesProfile/profile/countiesByState.action?entityld=8384&state=Montana) , Nebraska

{/speclesProfile/profile/countiesByState.actionPentityld=83848 state=Nebraska) , Nevada

{{speciesProfile/profile/countiesByState. action?entityld=8384&state=Nevada) , New Hampshire

{/speciesProfile/profile/countiesByState.action ?entityld=83848&state=New Hampshire) , New Jersey
{speciesProfile/profile/countiesByState action?entityld=83848&state=New Jersey) , New Mexico

lilinois) , Indiana

IspeciesProfile/profile/countiesByState.action?entityld=8384&state=Mississi

{IspeciesProfile/profile/countiesByState.action?entityld=83844&state=New Mexico) , New York

{speciesProfile/profilelcountiesBySiate action Pentityid=8384&state=New York) , North Carolina

{(IspeciesProfile/profile/countiesByState.action?entityld=83848&state=North Carolina) , North Dakota

{IspeciesProfile/profile/counties By State.actionPentityld=83848&state=North Dakota} , Ohio

IspeciesProfile/profile/countiesByState.action?entityld=8384&state=0hio) , Oklahoma
{/speclesProfile/profile/countiesByState action?entityld=8384 &state=Oklahoma) , Oregon
{/speciesProfile/profile/countiesByState. action?entityld=83848&state=Oreqon) , Pennsylvania
{/speciesProfile/profile/countiesByState. action 7entityld=8384&state=Pennsylvania) , Rhode Island

{speciesProfile/profile/countiesByState action7entityld=83848&state=Rhode Island} , South Carclina
{IspeciesProfilelprofilelcountiesByState.action?entityld=83848&state=South Carolina) , South Dakota

{IspeciesProfile/profile/countiesByState.action?entityld=8384&state=South Dakota) , Tennessee
U/speciesProfile/profile/countiesByState.action7entityld=83848state=Tennessee) , Texas
(lspeciesProfile/profile/countiesByState.action?entityld=83848&state=Texas) , Utah
{ispeciesProfile/profite/counties ByState. action?entityld=83848&stafe=Utah) , Vermont
{{speciesProfile/profile/countiesByState. action?entityld=83848&state=Vermont] , Virginia
IspeciesProfite/profile/countiesByState. action Pentityld=8384&state=Virginia) , Washington

fomnnineDrafilabnrafilninsaimbic e Bu@iata antianPantibdd=0108A42 ctntawibfnckinatant  WAlack Virninia
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(/speciesProfile/profile/countiesByState.action Pentityld=8384&state=Wisconsin) , Wyoming

(IspeciesProfile/profile/counties ByState, action Pentityld=8384&state=Wyoming)

US Counties in which this population is known to occur: View All

{/speciesProfile/profile/countiesBySpeacies.action ?entityld=8384)
USFWS Refuges in which this population is known to occur: AGASSIZ NATIONAL WILDLIFE

REFUGE , ALAMOSA NATIONAL WILDLIFE REFUGE , ALLIGATOR RIVER NATIONAL
WILDLIFE REFUGE , ANAHUAC NATIONAL WILDLIFE REFUGE , ANKENY NATIONAL

WILDLIFE REFUGE ... Show All Refuges (Javascript:tegaleRefuges{'on'y)
For more information: htto:/lwww.fws.goviMidwestleagle/ (http:Hwww.fws.qov/Midwest/eadle/)

Current Listing Status Summary —

Recovery

. Status “

Threatenead

05/01/2008

Date' t_isted

Southwest Region {Region 2} (hitp:/www.fws.govisouthwest/)

Great Lakes-Big Rivers Region (Region 3)

Where Llsted

a Sonoran Desert
DPS

Lead Region

03/11/11967

lower 48 States

{http:fiwww.fws.govimidwesth

» Federal Register Documents

0212512010

01/15/2009

08/22/2008

(15/20/2008

06/01/2008

Date |

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B008

Most Recent Federal Register Documents (Showing 5 of 38 : view all
(IspeclesProftle!proflIeld:splavAI!Documents!fedreq actron?spccde BUGB})

Citatlon Page

756 FR 8601 8621

74 FR 2465 2467

73 FR 49647 49648

73 FR 29096 29098

73 FR 23966 23970

Tit!e
12 Mcmth Fmd;ng ona Petstaon To Llst the Sonoran Desert Pogulatlon of

the Bald Eaqle as a Threatened or Endangered Distinct Population
Segment (hitp:/frwebgate.access.gpo.govicyi-binfgetdoc.cgi?

dbname“201(} reqlster&domd fr25fe10 38)

dbname“2009 reguster&doc:d-fﬂ 5|a09 65)

Endanqered and Threatened erdEafe and Plants Status Rewew of the o
Bald Eagle (Haliaeetus leucocephalus) in the Sonoran Desert Area of

Central Arizona and Northwestern Mexico: Notice of continuing

information collection for a_status review
o.qovicai-bin/getdoc.cqi?

hitp://frwebgate.access.

AvaHabilltv of a Draft Environmental Impact Statement and Habltat

Conservation Plan, and Receipt of Applications for Incldental Take

dbname 2008 regrster&docrd~fr223u08 321

dbname“2008 reqrster&doond fr20my08-21)
i_astlnq the Potentlal Sonoran Desert Bald anle Distmct Populatlon

Permits (http:/ffrwebgate.access.qpo.govicai-bin/getdoc.cgi?

Fnltlat;on of Status Review for the Bald Eac;le (Hailaeetus Eeucocephalus)
in_the Sonoran Desert Area of Central Arizona and Northwestern Mexico
{http:/ifrwebgate.access.gpo.govicdi-binfgetdoc.cqgi?

Segment as Threatened Under the Endangered Species Act

hitp:/frwebgate.access.gpo.govicgi-binfgetdoc.cyi?
dbname-ZOOB reqnster&doc:d-fr01 my08- ‘20)

Most Recent Snemal Rule Publ[catlons !Showma 2 of2 \ S
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. Date
06/05/2007

02/14/1978

a Citéﬁon Page '

Authonzatlons Under the Balci and Golden anle Protectlon Act for Take

Page 4 of 7

Tltle

72 FR 31141 31155|of Eagles (http:/frwebgate access.gpo.govicgi-bin/getdoc.cai?

43 FR 6230 6233

» Recovery

dbname-2007 regzster&docnd—erSmG'i 271

Determmatlon of Certain Bald Eagle Pogulat:ons as Endangered or
Threatened {http:flecos.fws.gov/docs/federal register/fr183.pdf)

Recovery Plan Information Search (frear/pub/ConfigureRecActionReport.do?path=ROAR Custorn

Querles.Public Actions AdHoc)

» Information Search FAQs {http://www.fws.goviendangeredirecovery/ROAR FAQs%2008-05-

09 FINAL.pdf}
e e Current Recovery Plan(s} .
Date Title PEan Actlon Status Plan
. Vlew Implementatlon Proqress
R ry Plan for fic Bald Eagl . .
08/25/1986 genve lan for the Pacific Ba ade {lroaripubl/planimplementationStatus.action?|Final
{http:/fecos fws.qovidocs/recovery planl0604193.9dn
B documentld"400‘390)
View Imglementatlon Progress .
Southeastern States Bald Eagle Recovery Plan . _[Final
04/19/1989 {iroar/pub/planimplementationStatus.action? .
{hitp:llecos.fws.govidocsirecovery planf0604194.pdf) Ravisi
documentid 400142)
i P
Northern States Bald Eagle Recovery Plan Vlew mplementateon roqress . .
07/29/1983 froar/pub/planimplementationStatus.action?!Final
(http:flecos.fws.qov/docsirecovery plan/060309b.pdf);
T T 7 document!d 400110) o
Southwestern Bald Eagle Recovery Plan Vlew imp!ementatlon Progress . .
09/08/1982 {lroar/pub/ptanimplementationStatus.action?!Final
{http:/lecos fws.qovidocs/recovery plan10604192.pdﬂ
documentld-400078)
Chesapeake Bay Region Bald Eagle Recovery |[View Impiementatlon Proqress Final
09/27/1990iPlan - First Revision {IroaripublnlanimplementationStatus.action? Revisi
{hitp:/lecos.fws.govidocs/recovery g!an1900927.9dﬂ documentld 400074)
V I ;
Chesapeake Bay Bald Eagle Recovery Plan lew mplementation Progress ~ iFinal
09/27/1930 {{roar/pub/planimplementationStatus.action? .
;httQ:I!ecos.fws.govldocslrecoverg pian/0604191.pdf) Revisi
documentld 400072)
0““*" Rec‘“’e"y D°°“m9“ts (Sh"“""“g“ °f4) e
Date Cltatlon Page Tttfe Document Type
* iNotice Comment
Endangered and Threatened Wildlife and Plants: Draft [Period for
Post-Delisting Monitoring Plan for the Bald Eagle Monitoring Plan
07/09/2007/72 FR 37373 37374|(Haliaeetus leucocephalus) and Proposed Information * [Notice Doc.
Collection (hitp:/ffrwebgate.access. gpo.qovicdi- Availability, Post
bin/getdoc.cqi?dbname=2007 register&docid=fr09iv07-140) |Delisting
Monitoring Plan
Endangered and Threatened Wildlife and Plants; « Final Delisting
07/09/2007|72 FR 37345 37372|Removing the Bald Eagle in the Lower 48 States From | .

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B008
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Date | Citation Page  Titte | Document Type
(http".f!fh.vebctete access.gpo.govicqi- biniqetdoo.eqi’?' -
dbname"z()e? reqnster&doc:d-—frOQ:vUT 6)

Nat;onal Ba!d anie Manaqement Gmde[mes
06/05/2007172 FR 31156 31157 {hitp:/ffirwebgate access.apo.govicgi-binfgetdoc.cqi?
dbname-2007 req:ster&docld fr05m07 85\

ETWP; Proposed Rule to Remove the Bald Eagle in the . |Proposed
Lower 48 States From the List of Endangered and

07/06/1999:64 FR 36453 36464 T Delisting,
Threatened Wildlife
Recovered

(httg I.fecos fws. gov!docsffederai reglster.ffr3404 gdﬂ

. e e e De"Sf““g D°°“"“9“fs R
Date Tlt!e

07/09/2007 Draft Post dehstmq Monltormq P!an for the Bald anle (Hahaeetus Ieucocephalus)
|{docs/species/doc1062.pdf)

+ {Notice Doc.
Avaiiabiiity

» Critical Habitat
No critical habitat rules have been published for the Bald eagle.
» Conservation Plans

Habitat Conservation Pfans (HCP) (learn more {/docs/conservation plans/HCP Incidental Take,pdf})

Page 5 of 7

(Showmg 5 of 132 view all {IsgeclesProf:lelgrofﬂeld:sg!ayAlEDocuments!hcg action?sgcode*BUOS}) _

HCP Plan Summanes

OOOO-Amendment #1 46 Subd:wsmns (4 iow quahtv subdwns&ons)
(hitp://ecos fws.aoviconserv plans/serviet/qov.doi.hcp.serviets.PlanReport?
plan :d 1173&reqion 2&tvpe-HCP&riype-1)

OGOO-Amendment #1 46-Subdivisions (42 medlum quahtv subdlwsmns)
hitp:llecos.fws.goviconserv plans/serviet/gov.doi.hcp.serviets.PlanRenort?

Qian ld 1174&reg:on Z&tyge-HCP&rtyg 11

0001-A|elio James {hitp:/lecos.fws. Ctovlconserv pianslservlethov dol. hcp servlets PIanReport?

Qlan |d 1019&reg|on—2&t3{ge—HCP&rtyge—-11

0o12- Km Wesley, D. (http:/lecos.fws., ovlconserv

Qian 1d—1355&reg:on-‘2&type—HCP&rtyg =1}
0021-Capstone Builders #1 (Wallman, Pam)
{http:liecos fws.goviconserv plansiservietigov.doi.hcp.serviets.PlanReport?

plan_id= 1179&region-2&tyge“HCP&rtyge i)

Safe E-Iarbor Agreements (SHA) (Iearn more Udocslconservatl &
SHA Pian Summarles

lansi/serviet/gov.doi.hcp.serviets.PlanReport?

Paterson ThomasW and Caroime H (Spur Ranch)

http:ffecos.fws goviconserv plansfserviet/gov.doi.hcp.serviets. PlanReport?
plan ld 995&reglon-2&!yge£SHA&rtyg =1}

Pueblo of Santa Ana Amendment # 1

(hitp:ilecos.fws.goviconservy plansiserviet/gov.doi.hcp.serviets.PlanReport?

B D L e Tt Lt T WOV JRRRVP, ¥ I DY ) I I N P SRR L ¥

http://ecos.fws.gov/speciesProfile/profile/speciesProfile.action?spcode=B008

 plans/Safetterbor,pd) (Showing § of §)
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. SHA plan Summanes e e e

Puebio of Santa Ana Safe Harbor Agreement

(hitp:/lecos. fws.goviconserv plans/serviet/qov.dol.hep.serviets. PlanReport?

g!an id= 3302&reglon-Z&ter"SHA&rter-1)

Taqshmnv Tree Farm {htip://ecos.fws. qov.fconserv p!ans.’servlethov doi.hep. servlets PIanReport?
p!an id= 909&reqton"1&tvpe-SHA&ﬂvpe-—ﬂ

Tempe City of, Rio Salado SHA (hitp: Hecos fws. qow‘conserv pfanslservieilqov doi.hcp. sewlets PIanReport?

plan id=3933&region=28type=SHA&rtype=1}

» Petitions
L. cent Petition Findings (Showing3of3)
Date itati Title. Finding |

12 Month Fmqu on a Petltlon To Llst the Sonoran Desert - |Notice 12
Poputation of the Bald Eagle as a Threatened or Endanaered [month

02/25/2010:75 FR 8601 8621 iDistinct Population Segment petition
http://frwebgate.access.qpo.govicgi-bin/getdoc.cqi? finding, Not
dbname=2010 reglster&doc:d-frZSfew 38! warranted
Petltlon to List the Sonoran Desert Popuiation of the Bald . ‘Notice 90-
Eagle as a Distinct Population Seament, List that Distinct day Petition

08/30/2006/71 FR 51549 51565|Population Segment as Endangered, and Desianate Critical Finding, Not
Habitat (http:/ffrwebgate. access.gpo.govicgi-bin/getdoc.cyi? "
substantial

dbname=2006 register&docid=fr30au08-38)

e
Findings on Petitions & Initiation of Status Reviews; 52 FR  |day Petition

2239-2242 {http:/fecos.fws.govidocs/federal register/fr1220.pdf}  iFinding, Not

substantial

01/21/1987|52 FR 2239 2242

» Life History
Movement / Home Range

Within 50 miles north of Southerly International Boundary between Arizona and Mexico, bald eagles may be
found along rivers and lakes as winter residsnts or migrants. There are no breeding sites within this specific
area.

» Other Resources

MatureServe Explorer Species Reports {{avascript:;) -- NatureServe Explorer is a source for authoritative

conservation information on more than 50,000 plants, animals and ecological communtities of the U.S and
Canada. NatureServe Explorer provides in-depth information on rare and endangered species, but includes
common plants and animals too. NatureServe Explorer is a product of NatureServe in collaboration with the
Natural Heritage Network.

ITiS Reports (javaseript::) -- ITIS (the integrated Taxonomic Information System) is a source for authoritative
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